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Introduction 
Congratulations on your choice of WizCom Technologies’ state-of-the-art QuickLink-Pen® Elite – the ultimate 
mobile note taker – used just like a yellow highlighter. 
 
Inside its tip, your Pen contains a sophisticated electronic eye mounted above two rollers. This eye enables 
you to scan printed information or small images directly into your Pen. Use the Pen to scan and store data 
and images, define scanned words by viewing their definitions in any of the dictionaries installed on your Pen, 
or send data directly to IrDA OBEX-compliant PDAs or Smartphones. This product also enables Pen-PC 
Communications: using the QuickLink-Pen® Elite Pen and QuickLink-Pen Elite Desktop application, you 
can scan real-time into applications on your computer or transfer the stored data to your PC at your 
convenience. 
 

Contact and Support Information 
If you have any questions about this product or how to use it, please feel free to contact us: 
• Send E-mail: usa.support@wizcomtech.com  
• Check our website at: http://www.wizcomtech.com  
Most technical problems are related to conflicts in particular hardware configurations and are not operational 
defects in the Pen or in the Desktop application. WizCom's technical support team is usually able to sort 
through these communications conflicts within minutes. 
 

Terminology 
Pen: 

The scanning device. 
Scan: 

To roll the Pen over printed text. Please refer to How to Scan on page 11 for more information. 
Highlighted: 

When text, numbers or graphics appear inversed on the Pen screen. For example, when text is 
highlighted, it appears green with a black background (instead of black text on the green background). 

Select: 
To ‘select’ an option means that you should scroll to the option – until it appears on the screen, or until it 
is highlighted and then press the Pen  button in order to activate the option or enter a sub menu or 
screen. 

Dictionary: 
In this manual, this is short for the current dictionary, used to define words in the Scan and Store files. 
The dictionaries on your Pen are the “The American Heritage® Concise Dictionary”, the “French-
>English” and the “English->French”. 

Dictionary Source Language: 
The dictionary source language is the language in which the headwords appear. The Pen can define 
words only if a dictionary with that source language is present on the Pen. For example, the source 
language of The American Heritage® Concise Dictionary is English, whereas the source language of the 
French to English dictionary is French. The first will be used to define English words, the latter will be 
used to define (translate) French words. 

Dictionary Target Language: 
The dictionary target language is the language in which the definitions appear on the Pen, in the 
Dictionary Screen. For example, the target language of both The American Heritage® Concise 
Dictionary and the French to English dictionary is English, therefore their definitions will appear in 
English. The target language of the English to French dictionary is French, therefore its definitions will 
appear in French. 

Dictionary entry: 
These are the entries from the dictionaries. Each entry consists of a headword in the source language 
and a definition in the target language. 

Pen-PC Communications: 
Functions that involve communications between the Pen and the computer and are performed when the 
Pen and PC are connected (cable or Infra-Red). 

PC-Link Connector: 
The outlet at the back of the Pen into which the cable plug is connected. 
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USB Cable: 

The cable provided in your package for connecting the Pen to the PC. This cable connects to the USB 
outlet of your computer and to the PC-Link Connector on the Pen. The Pen and PC communicate with 
what is called ‘serial’ communications. 

IR: 
Abbreviation of ‘Infra-Red’, which is an additional type of communications available for Pen-PC 
communications. 

 

Conventions 
• The procedures in this manual are accompanied with graphic icons of the buttons you need to press, for 

example, ‘Press ’ means you should press the bottom left Pen button. 
• The names of the menus and menu options are displayed in bold type, for example, ‘The scanning 

language is added to the Pen and can be set using the Set Scanning Language option in the Settings 
menu.’. 

 

Copyrights 
 
The American Heritage® Concise Dictionary, Third Edition Copyright 1994 by Houghton Mifflin Company. No part of this database may 
be reproduced or otherwise used without prior written permission from the publisher unless such use is expressly permitted by 
applicable law. No investigation has been made of common-law trademark rights in any word. Words that are known to have current 
trademark registrations are shown with an initial capital and are also identified as trademarks. The inclusion or exclusion of any word, or 
its capitalization, in this dictionary is not, however, an expression of the publisher's opinion as to whether or not it is subject to 
proprietary rights, nor is it to be regarded as affecting the validity of any trademark. American Heritage@ is a registered trademark of 
Forbes Inc. Its use is pursuant to a license agreement with Forbes Inc. 
 
ScanSoft® ScanSoft and the ScanSoft logo are trademarks or registered trademarks of ScanSoft. Inc. used in the US and/or in other 
countries. ScanSoft Text-to-Speech software © 2003 ScanSoft Inc. All rights reserved.  
 
WizCom Technologies Ltd. Copyright © 2006, WizCom Technologies Ltd. All rights reserved. WizCom Technologies Ltd. uses the 
Ligature OCR-on-a-Chip copyright © 1995-2003, Ligature Compression Technology copyright © 1996-2002 and Ligature reverse 
inflection and derivation technology copyright © 1997-2003 under license from Ligature Ltd. All rights reserved. WizCom QuickLink-
Pen, Quicktionary, Reading Pen, WizCom SuperPen, WizCom InfoScan, WizCom and Quicktionary pen shaped design are trademarks 
or registered trademarks of WizCom Technologies Ltd. Other trademarks are trademarks of their respective owners. 
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Getting Started 
 

Package Contents 
Before using your Pen, please take time to check the package contents to make sure that you have received 
all the following items. If anything is missing, please contact your QuickLink-Pen® Elite dealer. The package 
contents are: 
• Scanning Device (Pen) 
• USB Cable 
• CD-ROM - includes installations for add-ons, QuickLink-Pen Elite Desktop application, USB Driver and 

free CharacterEyes software (limited version) 
• Pen case with Opticard 
• Two AAA batteries 
• Earphones with volume control 

(Important: please lower the volume control before using the earphones to prevent ear irritation) 
• Documentation: French Manual, English Manual, Addendum for English manual, English Getting Started 

and English Quick Start Guide. Note: The Documentation folder of the CD contains the latest 
documentation. 

 

Set Up Product on PC 
Before starting to use the product you must first setup the product on your PC to allow Pen-PC 
Communications (i.e., the data and image transfer between the Pen and your computer). This setup 
procedure will install the USB driver, install the QuickLink-Pen Elite Desktop application and set the Pen-
PC communications settings. 
1. Insert the QuickLink-Pen® Elite CD-ROM into the CD-ROM drive of your computer. 
2. The Menu appears. 

Note: If the Menu does not appear automatically, please do the following:  
a. Click the Windows Start button and select Run. 
b. Type x: \setup.exe (where ‘x’ is your CD-ROM drive letter), then click OK. 

3. Click on the Set Up Product on PC button and follow the online instructions of the setup procedure 
provided. 

Note: You will only have to do this setup once. 
 

What Is Already On the Pen 
The Pen already contains the following: 
• Scan and Store application – used for scanning printed text and storing it on the Pen. You can also 

define words you have scanned and view their definition in the dictionary as well as beam data to a PDA 
or Smartphone. The dictionaries included are: 

a. AHD Concise English to English dictionary - (The American Heritage® Concise Dictionary), 
used for defining words from stored English texts. 

b. English->French dictionary, used for translating scanned English texts into French. 
c. French->English dictionary, used for translating scan French words into English. 

• Image Capture application– used for scanning small images and storing them on the Pen. 
• Send Stored Files to PC function - used for transferring stored files (from the Scan and Store 

application and from the Image Capture application) to the Desktop application and any host applications 
you have set. This function requires having already set up the product on your PC (see Set Up Product 
on PC on page 8). 

• Scan to PC application– used for scanning text and sending it directly to applications on your computer. 
This function requires having already set up the product on your PC (see Set Up Product on PC on page 
8). 

• The English Scanning Language – enabling to scan printed English text. 
• The French Scanning Language – enabling to scan printed French text. 
• The Spanish Scanning Language – enabling to scan printed Spanish text. 
• The German Scanning Language – enabling to scan printed German text. 
• The English Interface Language – all menu options and messages on the Pen appear in English. 
• The French Interface Language – all menu options and messages on the Pen appear in French. 
• The English Text to Speech software – enabling the Pen to read aloud stored English texts (in Scan and 

Store application). 
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Adding On to the Product 
You can add any of the following to the QuickLink-Pen® Elite product: 
• Applications: you can add the Address Book, Internet Links or Tables applications. These 

applications allow the scanning and storing of data on the Pen and transferring that data to the PC - using 
the Send Stored Files to PC function already on your Pen. The applications are added to the Pen Main 
Menu and into the Desktop application. 

• Scanning languages: scanning languages enable scanning printed text in other languages, in addition 
to English, French, German and Spanish which are already installed on your Pen. The scanning 
language is added to the Pen and is set using the Set Scanning Language option in the Settings menu. 

• Interface languages: interface languages enable displaying the pen menu options and messages in a 
certain language. Your Pen already contains the English and French. The interface language is added to 
the Pen and can be set using the Set Interface Language option in the Settings menu. 

To add on to the product: 
1. Insert the QuickLink-Pen® Elite CD-ROM into the CD-ROM drive of your computer. 
2. The Menu appears. 

Note: If the Menu does not appear automatically, please do the following: 
a. Click the Windows Start button and select Run. 
b. Type x: \setup.exe (where ‘x’ is your CD-ROM drive letter), then click OK. 

3. Click on the Install Add-Ons button. 
4. The Install Add-Ons menu appears, offering the available add-ons. 
5. Click on the add-on of your choice and follow the online instructions provided. 
 

Familiarizing Yourself with the Pen 
The scanning device (‘Pen’) contains the following parts: 
In the front you can see: 
• Pen Tip with optical scanning head 
• Protective cover 
• Power button 
• Keypad 
• Display 
• Built-in speaker 

 
In the back you can see: 
• Battery compartment cover 
• Battery compartment 
• Flash memory card socket 
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In the rear you can see the Pen outlets: 
• Earphone outlet 
• PC link connector (*for connecting the plug of the USB cable used for Pen-PC Communications). 

 
The Pen Buttons (keypad) 
The keypad contains seven buttons for operating your Pen: 
• The Power button  is used to turn the Pen on and off.  
• The Enter button  is used in a way similar to the Enter key on a computer keyboard. 
• The Escape button  is used in a way similar to the Esc key on a computer keyboard. 
• The Arrow buttons , ,  and  are used in a way similar to the arrow keys on a computer 

keyboard. 

 
Pressing the Buttons 
Press the Pen buttons as explained in the various procedures of this manual. The procedures in this manual 
are accompanied with graphic icons of the buttons you need to press (for example, ‘Press ’) and 
instructions on how to press them. 
There are a few ways in which to press the buttons. 
Note: not all types of presses are functional in all procedures. In the procedures of this manual you will be 
instructed as to the functions each press will perform. 
 
Here are the types of presses, which are used: 
Regular Press 
A single short press of the button. In this manual, when you are instructed to ‘Press’ a button – it means you 
should perform this Regular Press.  
Double-Click 
To double-click a button, press the button twice in rapid succession. 
Long-Press 
To long-press a button, press the button and hold it down briefly. 
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Button Functionality 
The specific functions of the Pen buttons are described in each of the procedures or instructions in this 
manual. Here are some of their general behaviors: 
General Behavior: 
• The  button will enter a sub menu or screen, confirm a selection or perform an operation. In addition, 

the  button has special functionalities on texts in an open Scan and Store file: 
a. Pressing  will read out loud the English texts of the current paragraph (see Reading 

Paragraphs Aloud on page 28).  
b. Long pressing  will open the definition for the current word, from the currently selected 

dictionary (see Defining Text in Scan and Store on page 29).  
c. Double-Click on  will open the Character Bar (see Editing Stored Files on page 27). 

• The  button will navigate backwards, close a screen, or cancel an operation. 
• Long pressing the  button will return to the Pen Main Menu. 
Selecting 
To select an item: 
1. Scroll through the menu or list using  and , until the item you want is highlighted or until it alone 

appears on the screen. 
2. Press .  
Navigating 
• To navigate forward – i.e., open a menu, sub menu or application, select the desired option and press 

.  
• To navigate backwards, return to a previous menu level or screen from a sub-menu or different screen 

and press . 
Closing Messages or Dialogs 
Some messages (for example, error messages) or dialogs (for example, addresses) display “buttons” on the 
screen. The buttons appear as a command (for example, YES, NO, CANCEL) with a circle around it (for 
example, ). 
Press  to activate a highlighted button (highlighted means in inversed text, for example, as in the button 

). If the button is not highlighted, use , ,  and  to scroll to the desired button, thus 
highlighting it and then press . 
 

Scanning 
Scanning means to roll the Pen over printed text (or over an image, as done in the Image Capture 
application only). When scanning, the optical head of the Pen scans the surface and creates an image of the 
scanned text which is transferred into the Pen and processed by the Pen applications. In all applications 
(except for the Image Capture) the image is processed resulting in the actual letters (this process is called 
Optical Character Recognition, or OCR). Further processing, using spelling lists and dictionaries, will result in 
the actual words. 
How to Scan 
Following are instructions on how to scan.  
For a short movie, demonstrating scanning, please access 
http://www.wizcomtech.com/presentations/main_18.html.  
Always make sure that: 
1. The Pen is on. 
2. The Pen Cap has been removed. 
3. The Pen is in scanning mode – denoted by the red blinking light at the tip of the Pen. 
If you are Left Handed:  
The Pen default is set to right handed scanning. To change it to left handed scanning, see Set Right/Left 
Handed on page 64. 
Scanning with the Trainer 
The transparent trainer is used for the initial scan practice: 

 
1. Slide the trainer on to the tip of the Pen (instead of the cap) and press firmly into place. 
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2. Scan from right to left. 
3. Place the trainer flat and steady to the right of the text you wish to scan. Notice the 90� angle that is 

created. This is the angle you should preserve whenever scanning, even without the trainer. 

 
4. The text should be positioned at the center of the opening of the trainer. 
5. Glide the Pen from right to left in a straight line over the text. The area you scan should start 1cm before 

the text, and end 1cm after it. Make sure that the text always appears between the 2 arrows on the 
trainer, as if being “fed” into the trainer.  

 
Scanning without the Trainer 
Once you get accustomed to scanning, you can scan without the trainer. 

 
1. Scan from right to left or from left to right. 
2. Place the Pen rollers on the page, approx. 1 cm before the beginning of the text, and roll the Pen over the 

text until 1 cm after the text. 
3. Make sure that the white guidelines at the Pen’s tip pass exactly over the middle of the scanned text. 
4. Maintain the 90� pen angle you have learned when scanning with the trainer. 
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5. When rolling over the text do not press down too hard on the Pen. 
6. Don’t scan too quickly. 
Tips for Good Scanning 
If you scan text, but the scanning results on the Pen (i.e., the recognized text) are not satisfactory, simply try 
scanning again.  
To ensure optimum scanning results: 

• When scanning Text, always make sure the Scanning Language is set to the language you are 
scanning. Check the general scanning language which is set in the Settings menu in the Pen Main 
Menu and check the scanning language set in the specific application you are scanning with, which 
is set in the Edit Menu of the application (N/A for Image Capture). 

• Make sure you are holding the Pen in the correct 90� angle. 
• Place the book/page on a flat surface. 
• The page must be light while the text or image you scan must be dark. 
• Make sure the printout is of high quality and the page is not creased. Note that photocopies may give 

poor results. 
• Avoid extreme lighting conditions. Light should not be too bright (e.g., direct sunlight) and not too dim. 
• Do not scan too fast. 

Note: If you do not succeed to improve text scanning results, try using the Character Bar or Opticard as 
alternative input methods. 
Scanning Limitations 
The Pen allows you to scan images (for the Image Capture application) up to 8mm high or printed text (for 
all other applications, such as the Scan and Store) 6-22 points in size (up to 8mm) in a wide variety of fonts 
and in all colors on contrasting backgrounds except: 
• Red on white 
• White on red 
• Blue on black 
• Black on blue
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Tutorials 
Following are tutorials to help you learn the basics of the QuickLink-Pen® Elite: 

Tutorial 1 – Scan and Store 
Tutorial 2 – Image Capture 
Tutorial 3 – Send Stored Files to PC 
Tutorial 4 – Scan to PC 

Important: 
• Before performing these tutorials, you must have already run the one time procedure Set Up 

Product on PC from the QuickLink-Pen® Elite CD-ROM. If you have not yet done this, please refer 
to Set Up Product on PC on page 8 and follow the instructions. 

• Please refer to How to Scan on page 11 for information on how the actual scanning is done. 
 

Tutorial 1 – Scan and Store 
This tutorial will take you through the basic usage of the Scan and Store application on the Pen.  
 
Step 1: Turn the Pen on 
Task: 
o Remove the protective cover from the Pen & press  to turn the Pen on. If the Pen Main Menu is not 

displayed, long press  until it is. 
The Pen display will show: 

 
The Pen Main Menu 

Step 2: Set Scanning Language 
Tasks: 
o Press  until the option Settings appears on the screen. 

o Press  to enter the Settings menu. 

o Press  until the option Set Scanning Language appears on the screen. 

o Press  to activate the current option and view the list of scanning languages. The black arrow at the 
left side of the one of the languages indicates that this is the current scanning language. 

o Press  and  until the black arrow is pointing at the option English. 
The Pen display will show: 

 
The list of Scanning Languages with English marked 

Tasks: 
o Press  to activate your selection.  
 
Your Pen is now set to scan and store English printed texts. This setting also defines the reading out loud 
language for the files created with this Scanning Language. For example, if you create a file when the 
Scanning language is set to English, and you scan and store texts in that file (English texts), when reading out 
loud the texts in this file – they will be read out as English. 
 
o Press  until you are back at the beginning of the Pen Main Menu. 
The Pen display will show: 

 
The Pen Main Menu 
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Step 3: Start the Scan and Store application 
Task: 
o Press  to activate the current option and enter the Scan and Store application. 
The Pen display will show: 

 
The main menu of the Scan and Store application 

 
Note: if you have already used this application, the screen will show the name of the last file you edited in the 
caption (instead of the No Open File message). 
Step 4: Create a new file and open it 
Tasks: 
o Press  and  until the option New File is highlighted. 

o Press  to activate the highlighted option. 

o Press  to scroll to the OK button and highlight it. 

o Press  to activate the highlighted button. 
The Pen display will show: 

 
A file, open and ready for editing, 

in the Scan and Store screen 
 

A new file named file001* is created, opened and ready for editing. 
 

*Note: if you have already used this application the file name will contain a different suffix (e.g., file004). 
Step 5: Scan a sentence into the open file 
Following is a sentence spread over 2 lines: 
 

Roll the scanning device over printed words 
and see how the words appear on your Pen. 

 
To scan this whole sentence you will need to scan the first line and then scan the second line. 
 
Task: 
o Please scan the first line. 
The Pen display will show: 

 
The first line you have scanned appears highlighted 

 
Note: If the scanned line was not recognized correctly, long press  to delete the highlighted text – and 
scan again. 
Task: 
o Now, continue and scan the second line. 
The Pen display will show: 

 
The whole sentence appears, the second line you have just scanned is highlighted 

Note: If the scanned line was not recognized correctly, long press  to delete the highlighted text – and 
scan again. 
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Step 6: Hear the sentence read out 
Task: 
o Press  to hear the sentence read out loud. 
The Pen display will show: 

 
The whole sentence (paragraph) is read aloud 

 
After the sentence is read aloud, the highlight is removed and the cursor is at the end of the sentence. 

Step 7: Scroll to a scanned word you wish to translate 
At this point you could do any of the following: 
• Scan more text. It will be added after the text you have already scanned. 
• Create a new paragraph by pressing .A new paragraph will open below a division line that will appear 

after the previously scanned text. You can now scan text into the new paragraph. 
• Define scanned words and view their dictionary entry: 
Task: 
o We will translate the word ‘device’: Use , ,  and  to scroll to the word ‘device’. The cursor 

should be placed within the word. 
The Pen display will show: 

 
The cursor is in the word ‘device’ 

Step 8: View the Dictionary Entry 
(in the Dictionary Screen) 

Task: 
o Long press  to define the word ‘device’ and view its dictionary entry in the Dictionary Screen.  

Note: Long pressing  in this case does not delete the text (as it would have in step 6) – because the text 
is not highlighted. 
Task: 
o If this is the first time you are defining text, and a  dictionary has not yet been selected, please proceed to 

Step 8.1, ahead. 
o If this is not the first time you are defining text, and a dictionary is already selected as the current 

dictionary, please proceed to Step 8.2. 
Step 8.1: Select the dictionary 
If this step (8.1) you have not yet selected a dictionary, therefore the Pen display will first show the following: 

 
The Select Dictionary list 

Tasks: 
o Press  and  until the option English->French is highlighted. 

o Press  to activate your selection.  
The Scan and Store application is now set to translate English words (which you have already scanned and 
stored) - into French. 
The Pen display will show: 

 
The dictionary entry of ‘device’ displayed in the Dictionary Screen 

Task: 
o Proceed to Step 9. 
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Step 8.2: Select the dictionary 
Case 2: 
If you have already selected a dictionary, the Pen will display the definition of the word ‘device’ from the 
current dictionary. 
 
Tasks: 
o Press  as many times as necessary until the Edit Menu is displayed. 

o Press  to scroll to the option Select Dictionary and highlight it. 

o Press  to activate the highlighted option and view the list of dictionaries on your Pen. The highlighted 
option indicates the current dictionary. 

o Press  and  until the option English->French is highlighted. 

o Press  to activate your selection. 
 
The Scan and Store application is now set to translate English words (which you have already scanned and 
stored) - into French. 
Task: 
o Again, long press  to define the word ‘device’ and view its dictionary entry in the Dictionary Screen.  
The Pen display will show: 

 
The dictionary entry of ‘device’ displayed in the 

Dictionary Screen 
Step 9: Exercise the Dictionary Screen 
Tasks: 
o Press  and  to scroll through the definitions of the dictionary entry. 

o Press  to expand the view, adding additional elements to the definition, such as Phonetics. The scroll 
arrow in the Dictionary Screen denotes the current state of the display: a hollow arrow ( ) denotes that 
the display is condensed, a full arrow ( ) denotes that the display is full. 

Step 10: Return to the open file 
Task: 
o Press  to return to the open file.  
The Pen display will show: 

 
The cursor is still in the word ‘device’ 

At this point you can continue doing any of the following: 
Tasks: 
o Read out a paragraph (press ) 

o Scroll through the words of the scanned text and define any of them (long press ). 

o Open new paragraphs by pressing  at the end of the scanned text. 
o Place the cursor at any point where you would like to scan in new test – and just scan. 
Step 11: Return to the Pen Main Menu 
Task: 
o Press  3 times to close the Scan and Store application and return to the Pen Main Menu. 
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Tutorial 2 – Image Capture 
This tutorial will take you through the basic usage of the Image Capture application on the Pen. 
 
Step 1: Turn the Pen on 
Task: 
o Remove the protective cover from the Pen & press  to turn the Pen on. If the Pen Main Menu is not 

displayed, long press  until it is. 
The Pen display will show: 

 
The Pen Main Menu 

Step 2: Start the Image Capture application 
Task: 
o Press  as many times as necessary until Image Capture appears on the screen. 

o Press  to activate the current option and enter the Image Capture application. 
The Pen display will show: 

 
The menu of the Image Capture application 

Step 3: Create a new file and open it 
Tasks: 
o Press  to activate the highlighted option (Scan New File). 

o Press  to scroll to the OK button and highlight it. 

o Press  to activate the highlighted button (OK). 
The Pen display will show: 

 
A file open in the Image Capture application 

 
A new file named image001* is created, opened and ready. 

 
*Note: if you have already used this application the file name will contain a different suffix (e.g., image004). 
Step 4: Scan an image into the open file 
Task: 
o Please scan the following signature of Pablo Picasso: 
 
 

 
 
 



QuickLink-Pen® Elite Operation Manual 

 19 

 
The Pen display will show: 

The top left corner of the scanned image. 
o Use , ,  and  to scroll through the image. 

o Press  to zoom in and out. 
Step 5: Return to the Main Menu 
Task: 
o Press  twice to close the Image Capture application and return to the Pen Main Menu. 
 

Tutorial 3 – Send Stored Files to PC 
This tutorial will take you through the basic usage of the Send Stored Files to PC function which involves 
Pen-PC Communications. 
Important: 
Before performing this tutorial, you must have already run the one time procedure Set Up Product on PC 
from the QuickLink-Pen® Elite CD-ROM. If you have not yet done this, please refer to Set Up Product on PC 
on page 8 and follow the instructions. 
 
Step 1: Prepare the PC 
Task: 
1. Turn your PC on. 
2. Close any applications that are running on your computer. The icons of applications that are running 

appear in the System Tray (located at the bottom right corner of the Windows screen). It is especially 
important to close applications that use the serial port or USB ports of your computer, such as PDAs or 
digital camera applications. 

3. Activate the QuickLink-Pen Elite Desktop application that you have already installed during the CD-
ROM procedure Set Up Product on PC: 

o If, during installation, you chose to add the Desktop to your computer’s startup, the Desktop will 
automatically start running when you start your computer. To maximize the Desktop window, click 
on the Desktop icon in the system tray at the bottom right side of the screen. If the Desktop 
window does not appear, select the Show Window option from the pop-up menu. 

o If the Desktop application does not run when you start up your computer, or if you have closed 
the application, you can start it by clicking the Windows Start menu and selecting 
Programs\QuickLink-Pen Elite Desktop\QuickLink-Pen Elite Desktop. 

4. Connect the cable to your Pen and PC (the same way you did during the CD-ROM procedure Set Up 
Product on PC). 

Step 2: Prepare the Pen 
Task: 
o Press  to turn the Pen on. If the Pen Main Menu is not displayed, long press  until it is. 
The Pen display will show: 

 
The Pen Main Menu 

Task: 
o Press  as many times as necessary until the option Send Stored Files to PC appears on the screen. 
The Pen display will show: 

 
The Pen Main Menu 
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Step 3: Send the Stored Files to the Desktop Application 
Task: 
o Press  to activate the Send Stored Files to PC function. 
The Pen display will show: 

 
If First Time: 
If this is the first time you have ever sent stored files to the Desktop, you will see the following dialog on the 
PC: 

 
Task: 
o Press Next. 

 
Task: 
Press Finish. 
If NOT First Time: 
If this is not the first time you have sent stored files to the Desktop or if you have just closed the above 2 
dialogs, you will see the following dialogs on the PC: 
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During the Send 

 
When the Send is completed 

Task: 
Press OK 
Step 4: View the Sent Text File in the Desktop Application 
Task: 
o In the left pane of the Desktop application window, click on the icon of the application whose files you 

wish to view. To view the text file you have created in Tutorial 1 - click on the Scan and Store icon: 

 
The Scan and Store icon in the Desktop left pane 

 
Scan and Store in the Desktop application 

 
The Desktop will open the selected application and display its list of files - in the middle pane* and its current 
file in the right pane. 
*Note: some applications do not have a middle pane. 
Step 5: View the Sent Image File in the Desktop Application 
Task: 
o In the left pane of the Desktop application window, click on the icon of the application whose files you 

wish to view. To view the image file you created in Tutorial 2 - click on the Image Capture icon: 

 
The Image Capture icon in the Desktop left pane 
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Image Capture in the Desktop application 

 
The Desktop will open the selected application and display its list of files - in the middle pane* and its current 
file in the right pane. 
*Note: some applications do not have a middle pane. 
 

Tutorial 4 – Scan to PC 
This tutorial will take you through the basic usage of the Scan to PC application which involves Pen-PC 
Communications. 
Important: 
Before performing this tutorial, you must have already run the one time procedure Set Up Product on PC 
from the QuickLink-Pen® Elite CD-ROM. If you have not yet done this, please refer to Set Up Product on PC 
on page 8 and follow the instructions. 
 
Step 1: Prepare the PC 
Tasks: 
1. Turn your PC on. 
2. Close any applications that are running on your computer. The icons of applications that are running 

appear in the System Tray. It is especially important to close applications that use the serial port or USB 
ports of your computer, such as PDAs or digital camera applications. 

3. Activate the QuickLink-Pen Elite Desktop application that you have already installed during the CD-
ROM procedure Set Up Product on PC: 

o If, during installation, you chose to add the Desktop to your computer’s startup, the Desktop 
should already be active (see if the Desktop icon appears in the system tray at the bottom right 
side of the screen). 

o If the Desktop application does not run when you start up your computer, or if you had closed it, 
you can start it by clicking the Windows Start menu and selecting Programs\QuickLink-Pen 
Elite Desktop\QuickLink-Pen Elite Desktop. 

4. Open the text file you wish to scan text into. The Pen can send text into any open file with an active 
cursor. For example, activate the Notepad application (click the Windows Start menu and select 
Programs\Accessories\Notepad. 
The Notepad application opens and an “Untitled” file is opened and ready for editing. 

5. Connect the cable to your Pen and PC (the same way you did during the CD-ROM procedure Set Up 
Product on PC). 

Step 2: Prepare the Pen 
Task: 
o Remove the protective cover from the Pen & press  to turn the Pen on. If the Pen Main Menu is not 

displayed, long press  until it is. 
The Pen display will show: 

 
The Pen Main Menu 
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Task: 
o Press  as many times as necessary until the option Scan to PC appears on the screen. 
The Pen display will show: 

 
The Pen Main Menu 

Task: 
o Press  to activate the Scan to PC application. 
The Pen display will show: 

 
The Scan to PC screen 

Step 3: Scan a sentence and send it to the PC 
Task: 
o Scan the first line of the following sentence: 
 

Roll the scanning device over printed words 
and see how the words appear in Notepad. 

 
After the sending is carried out, you will see the scanned line in Notepad. The cursor will blink right after the 
text, awaiting additional input. 
Task: 
o Now scan the second line of the above sentence. 
 
The second line appears right after the first line – completing the sentence. 
Step 4: Return to the Main Menu 
Task: 
o Press  to return to the Pen Main Menu. 
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The Pen Main Menu 
The Pen Main Menu is the menu that appears when no application, menu or option has been selected or 
entered. All applications and functions can be accessed from here. When adding on applications to the Pen – 
the add on applications are added to this menu. 
 

Accessing the Pen Main Menu 
When initially turning on the Pen, it opens in the Pen Main Menu. If you shut the Pen off while in an 
application – then next time you turn on the Pen it will open up in that application. 
• At all times - long press  to reach the Pen Main Menu. 
 

Selecting Options 
To select an application, option or menu from the Pen Main Menu, scroll using  and  until the desired 
option appears on the screen and then press . 
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The Scan and Store Application 
The Scan and Store application is used to scan and store notes and excerpts into text files. Using this 
application you may also access dictionary definitions for words you choose from the stored texts. Once you 
have stored a file, you can transfer it to your computer using the Send Stored Files to PC option (from the 
Pen’s Main Menu) or to a PDA by selecting Beaming from the application menu. 
 

Accessing Scan and Store Application 
1. Long press  until you reach the Pen Main Menu. 
2. Select the Scan and Store option. 
3. The Scan and Store application starts and its main menu appears. 
 

The Scan and Store Menu Options 
 

The Scan and Store Main Menu 
The main menu contains the high level options of the Scan and Store application. 
Accessing the Main Menu 
To access the main menu of the application, select Scan and Store from the Pen Main Menu. When already 
in the Scan and Store application press  to reach the Scan and Store main menu. 
 
Following is a description of the main menu options: 
Main Menu Caption – Current File 
The caption of the Scan and Store main menu displays the current file. If no file is open – the caption 
displays No Open File. 
Edit Current File 
To edit the current file. 
1. Select Edit Current File. The ‘current’ file is the last file you have worked on - whose name is displayed 

in the caption of the Scan and Store main menu. 
2. The file is opened and the cursor appears in the last position it was when you last edited this file. 
3. The file is ready for editing. See Editing Stored Files on page 27 for information on editing stored files. 
New File 
To create a new file:  
1. Select New File. The Enter file name dialog box opens with an automatically generated name displayed 

in the file name field, in Scan mode (no blinking cursor). 
Note: If you want to edit the file name, you can scan in a new name (which will overwrite the highlighted 
text) or edit the file name manually by pressing  once to enter Edit mode and then you can do any of 
the following: press  to display the Character Bar (see The Character Bar on page 67) or scan the 
Opticard key to activate the Opticard (see The Opticard on page 69). You may also press  to access 
the file name Edit Menu (this menu contains options specifically intended for editing file names, see The 
File Name Edit Menu on page 67). 

2. Press  to highlight the OK button and press  to open the new file. 
3. The cursor will appear at the beginning of the new file. 
4. The file is ready for editing. See Editing Stored Files on page 27 for information on editing stored files. 
Open File 
To open an existing stored file: 
1. Select Open File. A list of existing files appears. 
2. Select the file you want to open. 
3. The cursor will appear at the end of the file. 
4. The file is ready for editing. See Editing Stored Files on page 27 for information on editing stored files. 
Delete File 
To delete an existing stored file: 
1. Select Delete File. 
2. Select the file you want to delete. 
3. Select YES when the confirmation message appears. 
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Beaming 
Sends and receives stored files using Infra-Red communications. You can use this option to send a file to an 
IrOBEX-compliant device like a PDA or a Smartphone or to receive a file from such a device and save it in a 
file on your Pen. 
Note: The Communications Settings are not used for the Beaming functions. 
Beam Current File 
1. Make sure the device is ready to receive the file. 
2. Select the file to send to the device.  

Note: The Pen always sends the current file. The name of the current file is displayed at the top of the 
Scan and Store Main Menu. 
To select a different file:  
a. Select Open File from the Scan and Store Main Menu. 
b. Select the desired file from the list of files on your Pen. The selected file is now the ‘current’ file. 

3. Select Beaming. The Beaming submenu opens. 
4. Select Send File. The Pen displays a Sent successfully message if the file was sent, or an error 

message - if the transfer failed. 
Note: To use the Beaming features you must align the IR ports of the two devices. The IR port is located at 
the rear of the Pen. 
Receive File 
1. Select Beaming. The Beaming submenu opens. 
2. Select Receive File. 
3. Send the note. When the Pen receives the note, it displays the message Received successfully. 
Note: To use the Beaming features, you must align the IR ports of the two devices. The IR port is located at 
the rear of the Pen. 
Exit 
Exits the Scan and Store application and returns to the Pen Main Menu. 
 

The Scan and Store Edit Menu 
The Edit Menu contains additional options which affect the editing of the current open file. 
Note: an additional Edit Menu is available from the Enter file name dialog box with options for editing the file 
name (see The File Name Edit Menu on page 67). 
 
Accessing the Edit Menu 
When inside an open Scan and Store file (see Creating and Opening Stored Files on page 27) - press  
once to access the Edit Menu of the application.  
Following is a description of the Edit Menu options: 
Resume Editing 
Select this option to close the Edit Menu and return to the text. 
Activate Overwrite Mode/Activate Insert Mode 
This toggle option is a general option relating to the usage of the Character Bar. For information on this 
option, see Insert Mode and Overwrite Mode on page 68 in ‘The Character Bar’ section of this manual. 
New Paragraph 
Inserts a new paragraph between two paragraphs. 
1. Place the cursor on the paragraph you want the new paragraph to follow. 
2. Press  to open the Edit Menu. Note: If the cursor is at the end of the last paragraph (and not 

between 2 existing paragraphs) – you could simply press  to add a new paragraph. 
3. Select New Paragraph. A new paragraph is inserted after the selected paragraph (it appears after a 

separating line) and the cursor is positioned at the beginning of the new paragraph. 
Delete Paragraph 
Deletes a paragraph.  
1. Place the cursor on the paragraph you want to delete. 
2. Press  to open the Edit Menu. 
3. Select Delete Paragraph. 
4. The cursor will appear at the end of the previous paragraph. 
Select Language 
Use this option to change the scanning language if the material you are scanning is in a different language. 
When the Scanning Language setting matches the language of the printed text – the scanning results are 
optimal since a spelling check for that specific language is performed. 
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Important: 
This setting affects future scanning into the current file only. This may be useful when scanning different 
languages into one file. If you wish to change the general setting of the Pen, which will affect all new files 
created on the Pen, in all of the applications, then please change the scanning language in the Set Scanning 
Language option in the Settings menu of the Pen Main Menu (see Set Scanning Language on page 62). 
To select a scanning language: 
1. Open a new paragraph. Note: You cannot change the scanning language if text already exists in the 

current paragraph. Open a new paragraph before you change the scanning language. Otherwise, the 
Pen will ask you to delete the existing text. 

2. Press  to open the Edit Menu. 
3. Select the Select Language option. The current language appears highlighted. 
4. Select the language you want. 
5. This setting affects future scanning into the current file only. Any new file created will be set to the 

scanning language that is set in the Set Scanning Language option in the Settings menu of the Pen 
Main Menu. 

Important: only texts scanned when the scanning language was set to English, can be read aloud (see 
Reading Paragraphs Aloud on page 28). 
Select Dictionary 
Important: This option will appear only when more than one dictionary has a source language equal to the 
current scanning language. 
Use this option to change the dictionary used for defining the scanned words stored in the Scan and Store 
files. 
To select a different dictionary: 
1. From the file you are editing press . 
2. From the Edit Menu chose the Select Dictionary option. The Select Dictionary submenu opens. 
3. Select the dictionary you wish to use.  

a. If the stored text is English, select the AHD Concise dictionary to define the English words, 
or select the English->French to translate them. 

b. If the stored text is French, this option will not appear, since there is only one dictionary 
whose source language is French – the French->English dictionary. 

Scanning Options 
Allows to set the Pen for scanning inverse text (bright text on dark background) and/or digits. 
1. Press  to access the Edit Menu. 
2. Select Scanning Options.  
3. Press , , or  to toggle an option on or off. A checkmark (�) is displayed when the option is on.  
4. Press  to close the Scanning Options, save your settings and return to the open file. Small icons at 

the top right corner of the screen indicate the current settings (  and ). 
5. These settings affect editing in the current file only (i.e., if you create a new file, or even if you open a 

different file and then return to this file - these settings return to their default – which is off). 
 

Scanning and Storing Data 
 

Creating and Opening Stored Files 
From the Scan and Store main menu, select any of the following options: 
• Select Edit Current File to open the current file. The ‘current’ file is the one whose name appears in the 

caption of this menu. If no file is currently open, the message No Open File appears in the caption. In 
this case, selecting Edit Current File will first show the message No Open File and then show the Enter 
file name dialog box, suggesting a new file name. 

• Select New File to create a new file and then open it. The Enter file name screen will first appear 
suggesting a default file name. 

• Select Open File to select an existing file and open it. A list will first appear suggesting all available files. 
The file opens and the blinking cursor indicates the point at which text will be inserted. 

Editing Stored Files 
Easy Steps 
1. Create or open a file (see above). The cursor appears blinking at the beginning of the file (if it is a new 

file) or at the place it was when you previously closed this file (when it is not a new file). 
2. Scan in a line of English text. Note: if you want to scan text that is in a different language, see Select 

Language on page 26. If you want to scan numeric or inverse text, see Scanning Options on page 27. 
3. The new text appears on the screen at the cursor point and the new text is highlighted.  
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4. If the scanning result on the screen is not satisfactory and you would like to rescan the text, long-press 
 first to delete the highlighted text - and then scan the line again. 

5. When scanning continuously, each successive line of text you scan is entered into the file as a 
continuation of the previous line with a space inserted after the last word of the previously scanned text. 

6. Press  to insert a new paragraph into the file. 
7. If you wish to edit existing text, add on to it, or delete part of it, you can: 

• Scan: press ,  or  to de-highlight the text and position the cursor. Any scanned text will 
appear at the cursor position with spaces on each side. 

• Delete: long press  to delete highlighted text. After scanning in text – the new text appears 
highlighted – to allow this quick deletion of the latest scan. 

• Use Character Bar: press ,  or  to de-highlight the text and position the cursor; then double-
click  to display the Character Bar (see The Character Bar on page 67). 

• Use Opticard: press ,  or  to de-highlight the text and position the cursor and then scan the 
Opticard key on the Opticard and begin scanning Opticard keys as needed (see The Opticard on page 
69). 

• Use the Edit Menu: press  to access the Edit Menu (see The Scan and Store Edit Menu on page 
26). 

Navigation Shortcuts Within a File 
Double-clicking the arrow buttons quickly moves the cursor within an open file: 

Double-click 
this button 

To move the cursor to: 

 
The beginning of the file 

 
The end of the file 

 
The left edge of the current line. 

 
The right edge of the current line. 

Reading Paragraphs Aloud 
In the Scan and Store application it is possible to hear paragraphs of the English texts, stored in the files, 
read out loud by the Pen. The Pen reads texts aloud using the Text to Speech (TTS) engine installed on it. 
To read paragraphs aloud: 
1. When inside an open Scan and Store file - press  to hear the current paragraph (the one containing 

the cursor) - read out loud. 
2. The whole paragraph is read aloud. 
3. When done - the highlight is removed (if one existed) and the cursor moves to the end of the current 

paragraph. 
Notes: 
• The Pen only reads aloud English texts, i.e., texts that were entered into the file when the Scanning 

Language was set to English (see Select Language on page 26). If you attempt to read aloud text that 
was scanned in a different language, the Pen will display an error message. 

• The Pen reads aloud paragraphs only in the stored files of the Scan and Store application. 
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Defining Text in Scan and Store 
You can define words that appear in an open file of the Scan and Store application. 
The words will be defined using the current dictionary. Make sure that the language of the text you wish to 
define (according to the scanning language set at the time that the texts were scanned) matches the source 
language of the dictionary. 
Defining or Translating English Words 
To define English words or translate them into French, make sure that the text in the Scan and Store file had 
been scanned while the Scanning Language was set to English. See Set Scanning Language on page 62. 
Note: since the Pen contains more than one dictionary with the source language English, use the Select 
Dictionary option to chose the dictionary you wish to use (see Select Dictionary on page 27). 
Translating French Words 
To translate French words into English, make sure that the text in the Scan and Store file had been scanned 
while the Scanning Language was set to French. See Set Scanning Language on page 62. 
Choosing a Word to Define 
1. Open a file in the Scan and Store application (see Creating and Opening Stored Files on page 27). 
2. If the word you wish to define is not yet included in the text of this file – you can scan it in or add it 

manually using the Character Bar (see The Character Bar on page 67) or Opticard (see The Opticard on 
page 69). 

3. Press ,  or  to de-highlight any text and position the cursor within the word you chose to define. 

4. Long press  to view the dictionary entry of the chosen word. 
5. The Dictionary Screen appears – displaying the dictionary entry for the root of the chosen word. When 

the word you chose to define is an inflected form (for example, walked, which is the –ed form of the verb 
walk) – the Pen displays the entry of the root (walk).  

6. Some words may not be included in the dictionary (for example, proper names, like Joe or Alice), in 
which case the Pen will display the message Word not found. 

The Dictionary Screen 
The Dictionary Screen displays entries from the current dictionary. The current dictionary may be set to any of 
the 3 dictionaries on your Pen: The American Heritage® Concise Dictionary, the French to English dictionary 
or the English to French dictionary. Each entry defines, translates, describes and offers synonyms for one 
certain headword.  
After choosing a word to define (see Choosing a Word to Define on page 29), the relevant headword and 
entry from the dictionary are displayed in the Dictionary Screen. 
The Dictionary Entries 
Dictionary entries contain various elements and symbols. The main elements are shown when in the default 
display mode, which is condensed. Additional text elements (for example, Idioms and Phrasal Verbs) appear 
when changing the display to its full mode. 
Viewing the Dictionary Entries 
The scroll bars at the right side of the screen appear if there is more text to be viewed - above or below. Use 
the  and  buttons to scroll through the definitions in the dictionary entry. Double-Click the buttons to 
navigate quickly and hop between the main segments of the entry. 
At any time you can view additional information for the dictionary entry you are currently viewing in the 
Dictionary Screen. You may either expand the display so that all the additional information is displayed, or 
condense the display so that the additional text is hidden. 
Changing the Display Mode - Condensed and Full 
1. In the Dictionary Screen press  or  to toggle the display of the current entry - between condensed 

and full. 
2. The display of the dictionary entries will remain in the mode you have set – until you change it. 
How to know if the display mode is condensed or full 
At all times, the scroll arrow (that appears on the screen when displaying the dictionary entry) will indicate the 
current state of your display: 
• When the scroll arrow is hollow ( ), it means the display is condensed. 
• When the scroll arrow is full ( ), it means the display is full, displaying all the available information. 
Elements of the Dictionary Entries 
Following is a short description of the main elements and symbols that you may come upon when viewing 
dictionary entries. The descriptions are divided into two groups – those visible in the condensed display mode 
and those added to the display when the display is full. 
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Elements of the Condensed Display Mode 
Element or Symbol Example from the AHD Concise 

(marked in yellow) 
Headword 
This is the word which is defined in the 
dictionary entry. All headwords are of the root 
form. This means that when you define a word 
which is an inflected form, you are automatically 
shown the dictionary entry of the root. 

 
The headword of the entry ‘cat’ 

 

 
The headword of the entry ‘walk’, displayed when 

defining the word ‘walking’ 
Homonym Number 
Homonyms are headwords that are spelled the 
same way, but have different meanings. The 
small raised number means that the headword 
you are viewing is a homonym. Other 
homonyms are displayed in the Word List (see 
page 31). 

 
The homonym number of the headword, in entry fast1 

 

 
Element or Symbol Example from the AHD Concise 

(marked in yellow) 
Word List Sign 
When this sign appears, it means that there is a 
list suggesting homonyms or additional 
headwords.  
Press  to view the Word List (see page 31). 
Scroll through the list and press  to view the 
dictionary entry of the highlighted headword. 

 
The Word List sign in entry fast1 

 

 
The Word List for headword ‘fast’ 

Parts of Speech 
Words are used in different ways in a sentence. 
The way a word is used determines its part of 
speech. The dictionary entry is divided into 
sections for each part of speech (verb (v.), noun 
(n.), adjective (adj.), adverb (adv.), preposition 
(prep.), pronoun (pron.). 

 
The 1st part of speech (‘n.’, noun) in entry ‘letter’ 

Definitions 
Each part of speech may have a few meanings. 
Each meaning appears in a separate definition. 
The definitions are numbered; the first one is the 
most common meaning.  

Definitions (marked with numbers) in the part of speech 
‘adj.’ in entry ‘careless’ 

Sub Definitions 
Each definition may also have a few meanings. 
Each meaning appears in a separate sub 
definition. The sub definitions are marked with 
letters (A, B, C…).  

Sub definitions (marked with letters) in the first definition 
of the part of speech ‘v.’ in entry ‘abort’ 
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Element or Symbol Example from the AHD Concise 

(marked in yellow) 
Sample Sentences 
A sentence demonstrating the usage of the 
headword within a sentence. The example 
demonstrates how to use the headword as 
defined in the current definition. The same 
headword, in each separate definition, may be 
used differently. 

 
A sample sentence with the headword ‘let’, as defined in 

definition 2 of entry ‘let’ 
 

 
A sample sentence for using the word ‘let’ as defined in 

definition 4 of entry ‘let’ 
Labels 
Labels describe a specific field in which the 
headword is used, for example, Music. 

 
The Music label in entry ‘acoustic’ 

Note: Not all elements will appear in all dictionaries, nor in all entries. 
Elements Added in the Full Display Mode 
In addition to the elements described in the table above, the following elements may be added to the display 
– when it is in full mode (see Viewing the Dictionary Entries, page 29).: 
Element or Symbol Example from the AHD Concise 

(marked in yellow) 
Idioms and Phrasal Verbs 
These are phrases or expressions that contain 
the headword. The whole phrase is defined. A 
caption appears at the beginning of the section 
(Phrasal Verbs:, Idioms).  

The definitions of the phrasal verb ‘let down’ in entry ‘let’ 
 
Element or Symbol Example from the English to French 

(marked in yellow) 
Phonetics 
This is the phonetic transcription of the 
headword, indicating how the word should be 
pronounced. 

 
The phonetics of the word ‘cat’ 

Note: Not all elements will appear in all dictionaries, nor in all entries. 
  The Word List  

The Word List sign appears at the top of the entry displayed in the Dictionary Screen; it means that the 
current headword has an additional list of words to choose from and to view in the Dictionary Screen. 
When does the Word List appear? 
A Word List exists when: 

• The word you chose to define corresponds to two or more identical headwords with separate meanings 
(i.e., homonyms) 

Example (from the AHD Concise): bear1 (verb) and bear2 (noun). 
• The word you chose to define corresponds to more than one dictionary entry. 

Example  (from the AHD Concise): If you scan the word ‘cat’, you can choose between the matching 
headword 'cat' (which is a noun) and the headword ‘CAT’ (which is an abbreviation). 

Using the Word List: 
1. When the Word List sign appears in the top right corner of an entry in the Dictionary Screen - press . 

The word list for the selected word appears. 
2. Select the word you want. The dictionary entry for the selected word appears. 
3. To return to the word list, press  again. 
4. To exit the list and return to the Scan and Store file, press . 
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Exiting the Dictionary Screen 
Pressing  from the Dictionary Screen will return to the word you had originally chosen in the Scan and 
Store file. 

Scanning in Other Languages 
Please refer to Select Language on page 26. 

Closing and Saving Stored Files 
When inside an open Scan and Store file, press  twice to close the file. The text is saved in the file. 

Beaming Stored Files to a PDA 
Please refer to Beaming on page 26. 
 

Exiting the Scan and Store Application 
Long press  until you reach the Pen Main Menu. 
 

Sending Stored Files to the PC 
Important: 
The transferal of stored file info between the Pen and PC requires Pen-PC Communications. Therefore, you 
must have already run the one time procedure Set Up Product on PC from the QuickLink-Pen® Elite CD-
ROM. If you have not yet done this, please refer to Set Up Product on PC on page 8 and follow the 
instructions there. 
 
To send stored files to the PC: 
1. Turn your PC on. 
2. Make sure that your Pen and PC are connected. Note: they should be connected in the same manner 

you had chosen during the Set Up Product on PC procedure of the QuickLink-Pen® Elite CD-ROM. For 
example, make sure that the USB plug side of the USB cable is connected to the USB outlet on your PC 
and that the other side of the cable is connected to the PC-Link Connector outlet of your Pen. 

3. Start the QuickLink-Pen Elite Desktop application and make sure that Pen communications are on (see 
How to know if Pen Communications are on, on page 58). 

4. Turn the Pen on. 
5. Long press  until you reach the Pen Main Menu. 

6. Press  until Send Stored Files to PC appears on the screen. 

7. Press . The sending begins. Note: When performing Send Stored Files to PC, all stored files (from 
all storing applications) on your Pen are sent to the PC, according to the Pen-PC File Transfer Settings 
set in the Desktop application (see Setting the File Transfer Settings on page 52). 

8. When the process is done, OK the pop up in the QuickLink-Pen Elite Desktop. 
9. Click the Scan and Store icon in the QuickLink-Pen Elite Desktop application. 
10. The list of stored files you had transferred from the Pen - appear on the screen. 
Note: By default, the stored files of the Scan and Store application are copied from the Pen to the Desktop 
application and then deleted from the Pen. See File Transfer Settings for Scan and Store on page 55 for 
information on changing these settings, or having the files sent to additional PC applications such as MS 
Word. 
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The Image Capture Application 
The Image Capture allows to scan small images and store them on the Pen. Once you have stored a file you 
can transfer it to your computer using the Send Stored Files to PC option (from the Pen’s Main Menu). 
 

Accessing Image Capture Application 
1. Long press  until you reach the Pen Main Menu. 
2. Select the Image Capture option. 
3. The Image Capture application starts and its main menu appears. 
 

The Image Capture Menu Options 
The Image Capture Main Menu 
The main menu contains the high level options of the Image Capture application. 
Accessing the Main Menu 
To access the main menu of the application, select Image Capture from the Pen Main Menu. When already 
in the Image Capture application, press  to reach its main menu. 
Following is a description of the main menu options: 
Main Menu Caption – Current File 
The caption of the Image Capture main menu displays the current file. If no file is open, the caption displays 
No Open File. 
Edit Current File 
To edit the current file. 
1. Select Edit Current File. The ‘current’ file is the last file you had worked on whose name is displayed in 

the caption of the Image Capture main menu. 
2. The file is opened and its image is displayed (top left corner of the image). 
3. You can now scan in a new image. The new image will replace the old one. 
4. Press  to return to the main menu and save the changes. 
Scan New File 
To create a new image file: 
1. Select Scan New File. The Enter file name dialog box opens with an automatically generated name 

displayed in the file name field, in Scan mode (the text is highlighted).  
Note: If you want to edit the file name, you can scan in a new name (which will overwrite the highlighted 
text) or edit the file name manually by pressing  once to enter Edit mode. Then you can do any 
following: press  to display the Character Bar (see The Character Bar on page 67), or scan the 
Opticard key to activate the Opticard (see The Opticard on page 69. You may also press  to access 
the file name Edit Menu (this menu contains options specifically for editing file names, see The File Name 
Edit Menu on page 67). 

2. Press  to highlight the OK button and press  to open the new file. 
3. The Ready to scan an Image: message appears on the screen. 
4. You can now scan in a new image. 
5. Press  to return to the main menu and save the new file. 
Open File 
To open an existing stored file: 
1. Select Open File. A list of existing files appears. 
2. Select the file you want to open. 
3. The file is opened and its image is displayed (top left corner of the image). 
4. You can now scan in a new image. The new image will replace the old one. 
5. Press  to return to the main menu. 
Delete File 
To delete an existing stored file: 
1. Select Delete File. 
2. Select the file you want to delete. 
3. Select YES when the confirmation message appears. 
Exit 
Exits the Image Capture application and returns to the Pen Main Menu. 
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Scanning and Storing Images 
Creating and Editing Image Files 
From the Image Capture main menu, select any of the following options: 
• Select Edit Current File to open the current file. The ‘current’ file is the one whose name appears in the 

caption of this menu. If no file is currently open, the message No Open File appears in the caption. In 
this case, selecting Edit Current File will first show the message No Open File and then show the Enter 
file name screen, suggesting a new file name. 

• Select Scan New File to create a new file and then open it. The Enter file name screen will first appear 
suggesting a default file name. 

• Select Open File to select an existing file and open it. A list will first appear suggesting all available files. 
The file opens and the previous image appears (when editing an existing file), or the Ready to scan an 
Image: message appears on the screen (when creating a new file). 
You now scan in a new image. 

Closing and Saving Image Files 
When done scanning an image, press  to close the image file and save your changes. The Image 
Capture main menu is displayed. 
 

Exiting the Image Capture Application 
Long press  until you reach the Pen Main Menu. 
 

Sending Stored Images to the PC 
Important: 
The transferal of stored files between the Pen and PC requires Pen-PC Communications. Therefore, you 
must have already run the one time procedure Set Up Product on PC from the QuickLink-Pen® Elite CD-
ROM. If you have not yet done this, please refer to Set Up Product on PC on page8 and follow the 
instructions there. 
 
To send stored images to the PC: 
1. Turn your PC on. 
2. Make sure that your Pen and PC are connected. Note: they should be connected in the same manner 

you had chosen during the Set Up Product on PC procedure of the QuickLink-Pen® Elite CD-ROM. For 
example, make sure that the USB plug side of the USB cable is connected to the USB outlet on your PC 
and that the other side of the cable is connected to the PC-Link Connector outlet of your Pen. 

3. Start the QuickLink-Pen Elite Desktop application and make sure that Pen communications are on (see 
How to know if Pen Communications are on, page 58). 

4. Turn the Pen on. 
5. Long press  until you reach the Pen Main Menu. 

6. Press  until Send Stored Files to PC appears on the screen. 

7. Press . The sending begins. Note: When performing Send Stored Files to PC, all stored files (from 
all storing applications) on your Pen are sent to the PC, according to the Pen-PC File Transfer Settings 
set in the Desktop application (see Setting the File Transfer Settings on page 52). 

8. When the process is done, OK the pop up in the QuickLink-Pen Elite Desktop application. 
9. Click the Image Capture icon in the QuickLink-Pen Elite Desktop application. 
10. The list of image files you had transferred from the Pen - appear on the screen. 
Note: By default, the stored files of the Image Capture application are copied from the Pen to the Desktop 
application and then deleted from the Pen. See File Transfer Settings for Image Capture on page 55 for 
information on changing these settings. 
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The Add-On Applications 
 

Installing Add-On Applications 
There are three applications you can add to your Pen and Desktop, each allowing the storage of different 
types of data: Address Book, Internet Links and Tables. Each of the applications allows you to use the Pen 
to scan and store the data and then transfer that data to your PC. 
To install an add-on application to your Pen and Desktop: 
1. Insert the QuickLink-Pen® Elite CD-ROM into the CD-ROM drive of your computer. 
2. The Menu appears. 

Note: If the Menu does not appear automatically, please do the following:  
a. Click the Windows Start button and select Run. 
b. Type x: \setup.exe (where ‘x’ is your CD-ROM drive letter), then click OK. 

3. Click on the Install Add-Ons button. The Install Add-Ons menu appears 
4. Click on any of the buttons from the Pen and Desktop Add-On Applications section and follow the 

online instructions. 
After adding an application, it is added to the Desktop (to the list of icons appearing in the left pane) and to 
the Pen (listed in the Pen Main Menu). 
To use the add-on applications: 
1. Activate each Pen application to scan and store its type of data. 
2. Use the Send Stored Files to PC option from the Pen Main Menu to send all stored files (from these 

applications, too) to your PC 
3. View the sent data in the Desktop or in any host application you have set in the Pen-PC File Transfer 

Settings dialog of the Desktop (see Setting the File Transfer Settings on page 52). 
Following are detailed instructions for using each of the add-on applications. 
 

The Address Book Application 
In the Address Book application you can store information in entries containing name, address, phone 
number and other contact information. 
Important: This is an add-on application that is not included in your default product. To use it, you must first 
add it to your Pen and Desktop application, using the CD-ROM (see Installing Add-On Applications on page 
35). 

Accessing the Address Book Application 
1. Long press  to reach the Pen Main Menu. 
2. Select the Address Book option. 
3. The Address Book application starts and its main menu appears. 

The Address Book Menu Options 
The Address Book Main Menu 
Accessing the Main Menu 
To access the application’s main menu, select Address Book from the Pen Main Menu. When already in 
the menu options of the Address Book, press  to return to the Address Book main menu. When editing 
an address entry, see Closing and Saving Addresses on page 41 for instructions on returning to the main 
menu. 
Following is a description of the Address Book main menu options: 
Main Menu Caption – Current File 
The caption of the Address Book main menu displays the name of the main address book file File: 
mainadd. This is the current file. 
New Address 
Select this option to scan in a new Address Book entry.  
1. Select New Address. 
2. A new address opens and the first field appears in Scan mode. 
3. The address is ready for editing. See Editing Addresses on page 40 for information on editing addresses. 
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View Addresses 
Select this option to view the Address Book entries that are on your Pen: 
• Select View Addresses. A list appears consisting of Last Name , First Name of all addresses in the 

current Address Book file. 
The Addresses Menu 
When in the View Addresses list, it is possible to access the Addresses Menu which contains options for 
finding, deleting, viewing and editing specific addresses from the list. 
Accessing the Addresses Menu 
1. From the Address Book main menu, select View Addresses. 
2. Press  to open the menu. Note: To delete, view, or edit a particular address in the list, scroll to that 

address and then press . 
The following options are available in the Addresses Menu: 
Find Address 
Select this option to narrow the search for a specific address when you have a long list of Addresses. 
1. Press  from anywhere in the View Addresses list to access the Addresses Menu. 
2. Select Find Address. The Character Bar appears. 
3. Press  or  to scroll to the first letter in the address entry (e.g., the 'S' in Smith). The cursor jumps to 

the first entry in the list beginning with that letter. 
4. Press  and scroll to the second letter in the entry (e.g., the 'm' in Smith). The cursor jumps to the first 

entry in the list beginning with those two letters. 
5. Press  and scroll to the third letter in the entry, if necessary. 
6. When you find the address you want, press  to exit the Character Bar. 
7. Press  to select the found address. 
Select Search Language 
Select this option to change the search language for the above Find Address command. 
1. Press  from anywhere in the View Addresses list to access the Addresses Menu. 
2. Select the Select Search Language option. 
3. Select the language you want. 
Delete Address 
Select this option to delete the current address. 
1. In the View Addresses list scroll to the address you want to delete (until it is highlighted). 
2. Press  to access the Addresses Menu. 
3. Select Delete Address. 
4. When the confirmation appears, select YES. 
View Address 
Select this option to view the current address. 
1. In the View Addresses list scroll to the address you want to view (until it is highlighted). 
2. Press  or press  to access the Addresses Menu and then select View Address. 
3. The address is displayed in View mode, i.e. you can scroll through the address fields but you cannot 

make any changes. 
Edit Address 
Select this option to edit the current address. 
1. In the View Addresses list scroll to the address you want to edit (until it is highlighted). 
2. Press  twice or press  to access the Addresses Menu and then select Edit Address. 
3. The address opens and the first field appears in Scan mode. 
4. The address is ready for editing. See Editing Addresses on page 40 for information on editing addresses. 
Settings 
The Settings submenu lets you customize the way Address Book entries are created. You can use it to set 
a variety of options, from selecting the fields you would like included in each Address Book entry, to setting 
scanning and display options.  
Accessing the Settings Menu 
From the Address Book main menu select Settings. 
You can change more than one setting at a time. Once you have changed the settings, press  to return to 
the Address Book main menu. 
The Settings menu contains the following options: 
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Scroll Screen 
When Scroll Screen is selected, the display scrolls, rather than jumps, to the following field each time you 
finish scanning a line. This is the default.  
To toggle Scroll Screen on or off, press , , or . A checkmark (�) is displayed when it is on. 
Auto Advance 
When Auto Advance is selected, the display moves automatically to the next field when you finish scanning 
a line. This is the default. When Auto Advance is not selected, you must scroll manually from field to field 
after scanning in information by pressing .  
To toggle Auto Advance on or off, press , , or . A checkmark (�) is displayed when it is on. 
AutoName 
Select AutoName so that you can scan in both the first and last names at the same time. Automatically, the 
first name appears in the First Name field and the last name appears in the Last Name field. 
To toggle AutoName on or off, press , , or . A checkmark (�) is displayed when it is on. 
Next Address Lang. 
Use this option to change the scanning language in the Address Book if the material you are about to scan 
is in a different language than the current setting. When the Next Address Lang. setting matches the 
language of the printed text, the scanning results are optimal, since a spelling check for that specific 
language is performed. 
Important: 
This setting affects the scanning language of all future scanning into the Address Book application. If you 
wish to change the general setting of the Pen, which will affect all new files created on the Pen- in all of the 
applications, then please change the scanning language in the Set Scanning Language option in the 
Settings menu of the Pen Main Menu (See Set Scanning Language on page 62). 
 
To change the language prior to creating the new address: 
1. Select Next Address Lang.. 
2. Select the language you want. 

Note: the E-mail and Web Page fields are not affected by the change in language. 
Select Fields 
Select the Select Fields option to choose the fields you want in each address entry. You can choose any or 
all of the following fields: 

Title E-mail 
Company Web Page 
Address Home Phone 
Business Phone Home Fax 
Business Fax Notes 
Mobile phone   

Notes: 
• By default, all of the fields are selected. 
• The First Name and Last Name are mandatory for an address entry. 
To select or de-select a field:  
1. Select the Select Fields option. 
2. Scroll to the field until it is highlighted. 
3. Press , , or . A checkmark (�) is displayed when the field is selected. 
Field Settings 
Select the Field Settings option to change the default scanning options that will be set for each type of field 
when it is created. Adjusting these settings can increase scanning accuracy. For example, you might choose 
the Numeric field setting for the Business Phone field, because all of the characters that you scan into this 
field are numerals. 
The following scanning options are available for each field. You can select any or all of these settings for 
each field. 
• Numeric: For a string of numbers.  
• Inverse: For light text on a dark background. 
• Multiple Lines: For a field that can store more than one line of text. When this option is selected, a new 

line is opened in the same field after each line you scan. To continue to the next field you will need to 
press . By default, this option is selected for the Address and Notes fields. 

To set the scanning options: 
1. Select Field Settings. 
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2. Scroll to the field for which you want to change the settings, then press . 
3. Scroll to each option you want to set. 
4. Press , , or  to toggle the option on or off. A checkmark (�) is displayed when the option is on. 
5. Press  to return to the Field Settings menu and save the settings. Repeat steps 2-4 for each field 

whose settings you want to change. 
6. The settings are active for all future activities in the Address Book application. 

Note: To temporarily modify the scanning options for a specific field: 

• If the field is highlighted, press   
• If the field is not highlighted, press  to access the Edit Menu and then select Scanning 

Options.  
The Scanning Options menu opens. Whatever you had set will be active for the current field only. 

New File 
Important: 
The full Address Book functionality is only available for the main address book file ‘mainadd’, therefore, it is 
not recommended to work with multiple files in this application. The ‘mainadd’ file can be the only Address 
Book file that you need and it is recommended to work with this file only. However, you might want to 
organize your addresses differently by creating new files and storing your addresses in them selectively. 
To create a new file: 
1. Select New File. An Enter file name dialog box opens. 
2. Scan in a file name, or enter one manually. The Pen saves up to eight characters in the name. 

Notes: 
• The file name field is initially in Scan mode. If you scan text, the first eight letters that you scan are 

inserted in the file name field and the OK button is highlighted. If you want to rescan the name or edit 
it manually, press  first to return to the file name field.  

• To manually enter the file name, press  once. The file name field will then be in Edit mode. Now 
you can press  again to access the Character Bar (see The Character Bar on page 67), or scan 
the Opticard key of the Opticard to activate the Opticard (see The Opticard on page 69), or press 
again to view the file name Edit Menu (this menu contains options specifically for editing file names, 
see The File Name Edit Menu on page 67). 

3. Select OK. 
Open File 
If you have created additional Address Book files (using the New File option), select this option to open one: 
1. Select Open File. 
2. Select the file you want to open. 
Note: If your Pen contains only the mainadd file, this is the file that opens each time you select the Address 
Book application. If your Pen contains more than one Address Book file, the last file you had used opens 
automatically the next time you enter the Address Book application. 
Delete File 
If you have created additional Address Book files (using the New File option), select this option to delete 
one of these additional files from your Pen. 
Note: You cannot delete the mainadd file from your Pen. 
1. Select Delete File. 
2. Select the file you want to delete. 
3. Select YES when the confirmation appears. 
Note: If you delete the current file from your Pen, you must open an existing file before you can add additional 
addresses to the Address Book. 
Beaming 
The Beaming options allow sending an address entry to an IrOBEX-compliant device like a PDA or a 
Smartphone, or to receive an address from such a device. 
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Send Address 
To send an address from the Pen to a PDA: 
1. Make sure the device is ready to receive the address. 
2. Select Beaming. The Beaming submenu opens. 
3. Select Send Address. The list of addresses in the current file appears. 
4. Scroll to the address you want to send and press . The Pen displays a Sent successfully message if 

the address was sent, or an error message if the transfer failed. 
Note: To use the Beaming features, you must align the IR ports of the two devices. The IR port is located 
at the rear of the Pen. 

Receive Address 
To receive an address sent from a PDA: 
1. Select Beaming. The Beaming submenu opens. 
2. Select Receive Address. 
3. Send the address from the device. When the Pen receives the address, it displays the message 

Received successfully. 
Note: To use the Beaming features, you must align the IR ports of the two devices. The IR port is located 
at the rear of the Pen. 

Send Business Card 
Notes: 
• This option is available only when ‘mainadd’ is the current file.  
• You must have already selected an address as your Business Card (see the following option Select 

Business Card). 
To send your Business Card from the Pen to a PDA: 
1. Make sure the mainadd file is the current file. The name of the current Address Book file is displayed at 

the top of the Address Book main menu. If mainadd is not the current file, select it by doing the 
following: 

• Select Open File from the Address Book main menu. 
• Select the mainadd file from the list of files. The mainadd file is now the current Address Book file. 

2. Select Beaming. The Beaming submenu opens. 
3. Make sure the device is ready to receive the address. 
4. Select Send Business Card. The business card is sent.  

Notes: 
• To send your business card, you must have already selected one address as your business card (see 

the following option - Select Business Card). If you have not selected a business card you will get the 
message Business Card not defined. 

• To use the Beaming features, you must align the IR ports of the two devices. The IR port is located at 
the rear of the Pen. 

Select Business Card  
Notes: 
• This option is available only when ‘mainadd’ is the current file. 
• The address you select must be one already included in the ‘mainadd’ file. 
• To use the above Send Business Card option you must first select one address as your business card. 
To select an address to be your business card so that it will always be ready to send: 
1. Make sure the mainadd file is the current file. The name of the current address book file is displayed at 

the top of the Address Book main menu. If ‘mainadd’ is not the current file, select it by doing the 
following: 

• Select Open File from the Address Book main menu. 
• Select the mainadd file from the list of address book files on your Pen. The mainadd file is now the 

current file. 
2. Select Beaming. The Beaming submenu opens. 
3. Select the Select Business Card option. The list of addresses in the mainadd file appears. 
4. Scroll to the address you want to use as your business card and press  to select it. 
Exit 
Select this option to return to the Pen Main Menu. 
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The Address Book Edit Menu 
The Edit Menu contains additional options which affect the editing of the current address. 
Note: an additional Edit Menu is available from the Enter file name dialog box with options for editing the file 
name (see The File Name Edit Menu on page 67). 
Accessing the Edit Menu 
When in an open address (see Creating and Opening Addresses on page 40), make sure you are in Edit 
mode (the cursor should be blinking, see How to know which mode the Pen is in on page 41) and press  
once to access the Address Book Edit Menu. Following is a description of the Edit Menu options: 
Resume Editing 
Select this option to close the Edit Menu and return to the address. 
Activate Overwrite Mode/Activate Insert Mode 
This toggle option is a general option relating to the usage of the Character Bar. For information on this 
option, see Insert Mode and Overwrite Mode on page 68 in ‘The Character Bar’ section of this manual. 
Insert Line 
Inserts an additional line in the current field after the current line. 
Delete Line 
Deletes the current line from the entry.  
Clear Line 
Erases the contents of the current line and leaves the line blank. 
Scanning Options 
Select the Scanning Options to temporarily change the scanning option for the next time you enter text into 
the current field. To change the overall default, see Field Settings on page 37. 
The following scanning options are available. You can select any or all of these settings. 
• Numeric: For a string of numbers.  
• Inverse: For light text on a dark background. 
• Multiple Lines: To store more than one line of text. When this option is selected, a new line is opened in 

the same field after each line is scanned. To continue to the next field you will need to press . 
Press , , or  to toggle an option on or off. A checkmark (�) is displayed when the option is on. Press 

 to close the Scanning Options, save your settings and return to the field you were editing. 

Creating and Opening Addresses 
To create a new address: 
1. From the Address Book main menu, select New Address. 
2. A new address is created and opened for editing (in Scan mode, see Scan Mode on page 41). 
To open an existing address: 
1. From the Address Book main menu, select View Addresses. 
2. Scroll and highlight the address you wish to open for editing. 
3. Press . 
4. Select Edit Address. 
5. The address is opened, displaying its text (in Scan mode, see Scan Mode on page 41). You can now edit 

the address. 

Editing Addresses 
Easy Steps 
1. Create or open an address (see above). The First Name field appears and the file is in Scan mode (see 

Scan Mode on page 41) – meaning you can simply start scanning and the fields will accept the scanned 
text. 

2. Scan in the first name of the contact information you want to store (for example, from a business card). 
Note: if you want to scan text that is in a different language, see Next Address Lang. on page 37. If you 
want to scan numeric or inverse text, or if you want a field to contain more than one line, see Scanning 
Options on page 40. 

3. The first name you have scanned is placed in the First Name field (highlighted) and the Pen 
automatically advances to the next field which is Last Name (see Auto Advance on page 37). 

4. Continue scanning information into the entry fields. To skip a field, press .  
Note: By default, the Address and Notes fields are in Multiple Lines mode (see Field Settings, p. 37) 

5. If the scanning results on the screen are not satisfactory, you can edit the cell in various ways - see 
Editing Existing Text on page 41. 

6. When you have finished filling the fields, either select the OK button at the bottom of the entry, or press 
 (once – if in Scan mode, three times if in Edit mode).  
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7. The contact information you have just scanned is saved to your Pen as one new address entry. The 
Address Book main menu is displayed. 
Note: If the information you have scanned exceeds the width of the Pen display, you can see the entire 
text by viewing the address (see View Address on page 36). 

Editing Existing Text 
There are 2 modes for editing existing text – Scan mode and Edit Mode. The mode affects the editing of the 
current field - meaning you must currently be in an open field. 
Scan Mode 
This is the default mode in the Address Book application. When the current field is in Scan mode, scanning 
new text will delete any text from the whole field (if existing) and replace it with the new text you have 
scanned. This is useful for rescanning the whole field. 
Edit Mode 
When the current field is in Edit mode, you can do any following: 
• Insert Text: Scan new text you want to insert into the current field. Please scan whole words and not 

single characters (for single character editing use the Character Bar or the Opticard). The new text is 
inserted where the cursor was positioned and spaces are added to create correct word separation within 
the line of text. To quickly undo this new scan, simply press . This will delete the new scan which 
initially appeared highlighted (it is highlighted to allow this quick undoing). If you do not want to undo the 
new scan, press the arrow buttons to de-highlight the text, before entering more text. 

• Use the Edit Menu: press  to access the Address Book Edit Menu (see The Address Book Edit 
Menu on page 40). 

• Use the Character Bar: Press  to display the Character Bar (see The Character Bar on page 67) and 
edit the point at which the cursor is inserted. 

• Use the Opticard: Scan the Opticard key to activate the Opticard (see The Opticard on page 69) and edit 
the point at which the cursor is inserted. 

How to know which mode the Pen is in 
• In Scan mode the whole field appears with a black background and all the text is green. There is no 

blinking cursor.  
• In Edit mode there is a blinking cursor in the current field.  
Switching between Scan mode and Edit mode 
• If you are in Scan mode (no blinking cursor, field background is black), press  to switch to Edit mode. 
• If you are in Edit mode (blinking cursor), press  twice to switch to Scan mode. 
Navigation Shortcuts 
Double-clicking the arrow buttons quickly moves the cursor within the current field of an address entry (when 
the cursor is blinking in Edit mode). 

Double-click 
this button 

To move the cursor to:  

 
The beginning of the field 

 
The end of the field 

Scanning in Different Languages 
Please refer to Next Address Lang. on page 37. 
Closing and Saving Addresses 
When editing an address, scroll to the OK button and press  to close the address. Its contents are saved 
and the Address Book main menu appears. 
You may also press  in which case the Save changes? message will appear (note that if you were in Edit 
mode, the Edit Menu will appear. Press .to close it and press  again to reach the Save changes? 
message): 
• If you chose YES, the address closes, its contents are saved and the Address Book main menu 

appears. 
• If you chose NO, the address closes, its contents are not saved and the Address Book main menu 

appears. 
• If you chose CANCEL, you are brought back to the field you were editing. 

Viewing Addresses 
Please refer to View Addresses on page 36 and View Address on page 36. 

Beaming Stored Addresses to a PDA 
Please refer to Beaming on page 38. 
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Exiting the Address Book Application 
To return to the Pen Main Menu, press  from the Address Book main menu or select the Exit option 
below. 

Sending Stored Address Book to PC 
Important: 
The transferal of stored addresses between the Pen and PC requires Pen-PC Communications. Therefore, 
you must have already run the one time procedure Set Up Product on PC from the QuickLink-Pen® Elite 
CD-ROM. If you have not yet done this, please refer to Set Up Product on PC on page 8 and follow the 
instructions there. 
To send stored addresses to the PC: 
1. Turn your PC on. 
2. Make sure that your Pen and PC are connected. Note: they should be connected in the same manner 

you had chosen during the Set Up Product on PC procedure of the QuickLink-Pen® Elite CD-ROM. For 
example, make sure that the USB plug side of the USB cable is connected to the USB outlet on your PC 
and that the other side of the cable is connected to the PC-Link Connector outlet of your Pen. 

3. Start the QuickLink-Pen Elite Desktop application and make sure that Pen communications are on (see 
How to know if Pen Communications are on, page 58). 

4. Turn the Pen on. 
5. Long press  until you reach the Pen Main Menu. 

6. Press  until Send Stored Files to PC appears on the screen. 

7. Press . The sending begins. Note: When performing Send Stored Files to PC, all stored files (from 
all storing applications) on your Pen are sent to the PC, according to the Pen-PC File Transfer Settings 
set in the Desktop application (see Setting the File Transfer Settings on page 52). 

8. When the process is done, OK the pop up in the QuickLink-Pen Elite Desktop. 
9. Click the Address Book icon in the QuickLink-Pen Elite Desktop application. 
10. The list of addresses you had transferred from the Pen - appear on the screen. 
Note: By default, the addresses of the Pen and Desktop application are synchronized. See File Transfer 
Settings for Address Book on page 56 for information on changing these settings, or having the addresses 
sent or synchronized with additional PC applications such as MS OutLook. 
 

The Internet Links Application 
In the Internet Links application, you can store web addresses (URLs). 
Important: This is an add-on application that is not included in your default product. To use it, you must first 
add it to your Pen and Desktop application, using the CD-ROM (see Installing Add-On Applications on page 
35). 

Accessing the Internet Links Application 
1. Long press  to reach the Pen Main Menu. 
2. Select the Internet Links option. 
3. The Internet Links application starts and its main menu appears. 

The Internet Links Menu Options 
The Internet Links Main Menu 
Accessing the Main Menu 
To access the main menu of the application, select Internet Links from the Pen Main Menu. When already 
in the menu options of the Internet Links, press  to return to the Internet Links main menu. When 
editing a link entry, see Closing and Saving Links on page 46 for instructions on returning to the main menu. 
 
Following is a description of the Internet Links main menu options: 
Main Menu Caption – Current File 
The caption of the Internet Links main menu displays the name of the main internet links file File: mainlnk. 
This is the current file. 
New Link 
Select this option to scan in a new Internet Link entry.  
1. Select New Link. 
2. A new link is created and the first field appears in Scan mode. 
3. The link is ready for editing. See Editing Links on page 45 for information on editing links. 
View Links 
Select this option to view the Internet Link entries that are on your Pen: 
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• Select View Links. A list appears consisting of all links in the current Internet Link file. 
The Links Menu 
When in the View Links list it is possible to access the Links Menu which contains options for deleting, 
viewing and editing specific links from the list. 
Accessing the Links Menu 
1. From the Internet Links main menu select View Links. 
2. Scroll to the link you wish to delete, view or edit (until it is highlighted) 
3. Press  to open the menu. 
The following options are available in the Links Menu: 
Delete Link 
Select this option to delete the current link. 
1. In the View Links list scroll to the link you want to delete (until it is highlighted). 
2. Select Delete Link. 
3. When the confirmation appears, select YES. 
View Link 
Select this option to view the current link. 
1. In the View Links list scroll to the link you want to view (until it is highlighted). 
2. Press  or press  to access the Links Menu and then select View Link. 
3. The link is displayed in View mode, i.e., you can scroll through the link fields, but you cannot make any 

changes. 
Edit Link 
Select this option to edit the current link. 
1. In the View Links list scroll to the link you want to edit (until it is highlighted). 
2. Press  twice or press  to access the Links Menu and then select Edit Link. 
3. The link opens and the first field appears in Scan mode. 
4. The link is ready for editing. See Editing Links on page 45 for information on editing links. 
Settings 
The Settings submenu contains scanning and display options for link entries. 
Accessing the Settings Menu 
• From the Internet Links main menu select Settings. 
You can change more than one setting at a time. Once you have changed the settings, press  to return to 
the Internet Links main menu. 
The Settings menu contains the following options: 
Scroll Screen 
When Scroll Screen is selected, the display scrolls, rather than jumps, to the following field each time you 
finish scanning a line. This is the default.  
To toggle Scroll Screen on or off, press , , or . A checkmark (�) is displayed when it is on. 
Auto Advance 
When Auto Advance is selected, the display moves automatically to the next field when you finish scanning 
a line. This is the default. When Auto Advance is not selected, you must scroll manually from field to field 
after scanning in information by pressing .  
To toggle Auto Advance on or off, press , , or . A checkmark (�) is displayed when it is on. 
AutoDescribe 
Select AutoDescribe, so that after scanning the Internet Link field in a link entry, the Description field is 
automatically filled with the middle portion of the link – which is usually the company name. 
To toggle AutoDescribe on or off, press , , or . A checkmark (�) is displayed when it is on. 
Next Link Language 
Use this option to change the scanning language in the Internet Links - if the material you are about to scan 
is in a different language than the current setting. When the Next Link Language setting matches the 
language of the printed text, the scanning results are optimal since a spelling check for that specific language 
is performed. 
Important: 
This setting affects the scanning language of all future scanning into the Internet Link application. If you wish 
to change the general setting of the Pen, which will affect all new files created on the Pen, in all of the 
applications, then please change the scanning language in the Set Scanning Language option in the 
Settings menu of the Pen Main Menu (See Set Scanning Language on page 62). 
To change the language prior to creating the new link: 
1. Select Next Link Language. 
2. Select the language you want. 
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New File 
Important: 
The full Internet Links functionality is only available for the main Internet Links file ‘mainlnk’, therefore, it is 
not recommended to work with multiple files in this application. The ‘mainlnk’ file can be the only Internet 
Links file that you need and it is recommended to work with this file only. However, you might want to 
organize your links differently by creating new files and storing your links in them selectively. 
To create a new file: 
1. Select New File. An Enter file name dialog box opens. 
2. Scan in a file name, or enter one manually. The Pen saves up to eight characters in the name. 

Notes: 
• The file name field is initially in Scan mode. If you scan text, the first eight letters that you scan are 

inserted in the file name field and the OK button is highlighted. If you want to rescan the name or edit 
it manually, press  first to return to the file name field.  

• To manually enter the file name, press  once. The file name field will then be in Edit mode. Now 
you can press  again to access the Character Bar (see The Character Bar on page 67), or scan 
the Opticard key of the Opticard to activate the Opticard (see The Opticard on page 69), or press 
again to view the file name Edit Menu (this menu contains options specifically for editing file names, 
see The File Name Edit Menu on page 67). 

3. Select OK. 
Open File 
If you have created additional Internet Links files (using the New File option), select this option to open one: 
1. Select Open File. 
2. Select the file you want to open. 
Note: If your Pen contains only the mainlnk file, this is the file that opens each time you select the Internet 
Links application. If your Pen contains more than one Internet Links file, the last file you had used opens 
automatically the next time you enter the Internet Links application. 
Delete File 
If you have created additional Internet Links files (using the New File option), then select this option to 
delete one of these additional files from your Pen. 
Note: You cannot delete the mainlnk file from your Pen. 
1. Select Delete File. 
2. Select the file you want to delete. 
3. Select YES when the confirmation appears. 
Note: If you delete the current file from your Pen, you must open an existing file before you can add additional 
links to the Internet Links. 
Exit 
Select this option to return to the Pen Main Menu. 
The Internet Links Edit Menu 
The Edit Menu contains additional options which affect the editing of the current link. 
Note: an additional Edit Menu is available from the Enter file name dialog box with options for editing the file 
name (see The File Name Edit Menu on page 67). 
Accessing the Edit Menu 
When in an open link (see Creating and Opening Links on page 45), make sure you are in Edit mode (the 
cursor should be blinking, see How to know which mode the Pen is in on page 46) and press  once to 
access the Internet Links Edit Menu. Following is a description of the Edit Menu options: 
Resume Editing 
Select this option to close the Edit Menu and return to the link. 
Activate Overwrite Mode/Activate Insert Mode 
This toggle option is a general option relating to the usage of the Character Bar. For information on this 
option, see Insert Mode and Overwrite Mode on page 68 in ‘The Character Bar’ section of this manual. 
Insert Line 
Inserts an additional line in the current field after the current line. 
Delete Line 
Deletes the current line from the entry.  
Clear Line 
Erases the contents of the current line and leaves the line blank. 
Scanning Options 
Select the Scanning Options to temporarily change the scanning option for the next time you enter text into 
the current field. 
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The following scanning options are available. You can select any or all of these settings. 
• Numeric: For a string of numbers.  
• Inverse: For light text on a dark background. 
• Multiple Lines: To store more than one line of text. When this option is selected, a new line is opened in 

the same field after each line is scanned. To continue to the next field you will need to press . 
Press , , or  to toggle an option on or off. A checkmark (�) is displayed when the option is on. Press 

 to close the Scanning Options, save your settings and return to the field you were editing. 

Creating and Opening Links 
To create a new link: 
1. From the Internet Links main menu, select New Link. 
2. A new link is created and opened for editing. 
To open an existing link: 
1. From the Internet Links main menu, select View Links. 
2. Scroll and highlight the link you wish to open for editing. 
3. Press . 
4. Select Edit Link. 
5. The link is opened, displaying its existing text. You can now edit the link. 

Editing Links 
Easy Steps 
1. Create or open a link (see above). The Internet Link field appears and the file is in Scan mode (see 

Scan Mode on page 45) – meaning you can simply start scanning and the fields will accept the scanned 
text. 

2. Scan in the web address you want to store (for example, from a business card). Note: if you want to scan 
text that is in a different language, see Next Link Language on page 43. If you want to scan numeric or 
inverse text, or if you want a field to contain more than one line, see Scanning Options on page 44. 

3. The web address (URL) you have scanned is placed in the Internet Link field (highlighted) and the Pen 
automatically advances to the next field which is Description (see on Auto Advance on page 43). 

4. If the scanning results on the screen are not satisfactory, you can edit the cell in various ways - see 
Editing Existing Text on page 45. 

5. When you have finished filling the fields, either select the OK button at the bottom of the entry, or press 
 (once – if in Scan mode, three times if in Edit mode).  

6. The information you have just scanned is saved to your Pen as one new link entry. The Internet Links 
main menu is displayed. 
Note: If the information you have scanned exceeds the width of the Pen display, you can see the entire 
entry by viewing the link (see View Link on page 43). 

Editing Existing Text 
There are 2 modes for editing existing text – Scan mode and Edit Mode. The mode affects the editing of the 
current field, meaning you must currently be in an open field. 
Scan Mode 
This is the default mode in the Internet Links application. When the current field is in Scan mode, scanning 
new text will delete any text from the whole field (if existing) and replace it with the new text you have 
scanned. This is useful for rescanning the whole field. 
Edit Mode 
When the current field is in Edit mode, you can do any following: 
• Insert Text: Scan new text you want to insert into the current field. Please scan whole words and not 

single characters (for single character editing use the Character Bar or the Opticard). The new text is 
inserted where the cursor was positioned and spaces are added to create correct word separation within 
the line of text. To quickly undo this new scan, simply press . This will delete the new scan which 
initially appeared highlighted (it is highlighted to allow this quick undoing). If you do not want to undo the 
new scan, press the arrow buttons to de-highlight the text, before entering more text. 

• Use the Edit Menu: press  to access the Internet Links Edit Menu (see The Internet Links Edit 
Menu on page 44). 

• Use the Character Bar: Press  to display the Character Bar (see The Character Bar on page 67) and 
edit the point at which the cursor is inserted. 

• Use the Opticard: Scan the Opticard key to activate the Opticard (see The Opticard on page 69) and edit 
the point at which the cursor is inserted. 



QuickLink-Pen® Elite Operation Manual 

 46 

 
How to know which mode the Pen is in 
• In Scan mode the whole field appears with a black background and all the text is green. There is no 

blinking cursor.  
• In Edit mode there is a blinking cursor in the current field.  
Switching between Scan mode and Edit mode 
• If you are in Scan mode (no blinking cursor, field background is black), press  to switch to Edit mode. 
• If you are in Edit mode (blinking cursor), press  twice to switch to Scan mode. 
Navigation Shortcuts 
Double-clicking the arrow buttons quickly moves the cursor within the current field of an link entry (when the 
cursor is blinking in Edit mode). 

Double-click 
this button 

To move the cursor to:  

 
The beginning of the field 

 
The end of the field 

Scanning in Different Languages 
Please refer to Next Link Language on page 43. 
Closing and Saving Links 
When editing a link, scroll to the OK button and press  to close the link. Its contents are saved and the 
Internet Links main menu appears. 
You may also press  in which case the Save changes? message will appear (note that if you were in Edit 
mode - the Edit Menu will appear. Press .to close it and press  again to reach the Save changes? 
message): 
• If you chose YES, the link closes, its contents are saved and the Internet Links main menu appears. 
• If you chose NO, the link closes, its contents are not saved and the Internet Links main menu appears. 
• If you chose CANCEL, you are brought back to the field you were editing. 
 

Viewing Links 
Please refer to View Links on page 42 and View Link on page 43. 

Exiting the Internet Links Application 
To return to the Pen Main Menu, press  from the Internet Links main menu or select the Exit option 
below. 

Sending Stored Internet Links to PC 
Important: 
The transferal of stored links between the Pen and PC requires Pen-PC Communications. Therefore, you 
must have already run the one time procedure Set Up Product on PC from the QuickLink-Pen® Elite CD-
ROM. If you have not yet done this, please refer to Set Up Product on PC on page 8 and follow the 
instructions there. 
To send stored links to the PC: 
1. Turn your PC on. 
2. Make sure that your Pen and PC are connected. Note: they should be connected in the same manner 

you had chosen during the Set Up Product on PC procedure of the QuickLink-Pen® Elite CD-ROM. For 
example, make sure that the USB plug side of the USB cable is connected to the USB outlet on your PC 
and that the other side of the cable is connected to the PC-Link Connector outlet of your Pen. 

3. Start the QuickLink-Pen Elite Desktop application and make sure that Pen communications are on (see 
How to know if Pen Communications are on, page 58). 

4. Turn the Pen on. 
5. Long press  until you reach the Pen Main Menu. 

6. Press  until Send Stored Files to PC appears on the screen. 

7. Press . The sending begins. Note: When performing Send Stored Files to PC, all stored files (from 
all storing applications) on your Pen are sent to the PC, according to the Pen-PC File Transfer Settings 
set in the Desktop application (see Setting the File Transfer Settings on page 52). 

8. When the process is done, OK the pop up in the QuickLink-Pen Elite Desktop. 
9. Click the Internet Links icon in the QuickLink-Pen Elite Desktop application. 
10. The list of links you had transferred from the Pen - appear on the screen. 
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Note: By default, the links of the Pen and Desktop application are synchronized. See File Transfer Settings for 
Internet Links on page 56 for information on changing these settings, or having the links sent to or 
synchronized with additional PC applications such as MS Internet Explorer. 
 

The Tables Application 
The Tables application is used to scan and store tables and charts. 
Important: This is an add-on application that is not included in your default product. To use it, you must first 
add it to your Pen and Desktop application, using the CD-ROM (see Installing Add-On Applications on page 
35). 

Accessing the Tables Application 
1. Long press  until you reach the Pen Main Menu. 
2. Select the Tables option. 
3. The Tables application starts and its main menu appears. 

The Tables Menu Options 
The Tables Main Menu 
The main menu contains the high level options of the Tables application. 
Accessing the Main Menu 
To access the main menu of the application, select Tables from the Pen Main Menu. When already in the 
Tables application press  to reach the Tables main menu. 
Following is a description of the main menu options: 
Main Menu Caption – Current File 
The caption of the Tables main menu displays the current file. If no file is open, the caption displays No 
Open File. 
Edit Current File 
To edit the current table file: 
1. Select Edit Current File. The ‘current’ file is the last file you worked on, whose name is displayed in the 

caption of the Tables main menu. 
2. The file is opened and the cell you edited last appears in Scan mode. 
3. The file is now ready for editing. See Editing Tables on page 49 for information on editing tables. 
Settings 
The Settings submenu contains scanning and display options for tables. 
Accessing the Settings Menu 
• From the Tables main menu select Settings. 
You can change more than one setting at a time. Once you have changed the settings, press  to return to 
the Tables main menu. 
The Settings menu contains the following options: 
Scroll Screen 
When Scroll Screen is selected, the display scrolls, rather than jumps, to the following field each time you 
finish scanning a line. This is the default.  
To toggle Scroll Screen on or off, press , , or . A checkmark (�) is displayed when it is on. 
Auto Advance 
When Auto Advance is selected, the display moves automatically to the next cell on the right, when you 
finish scanning a cell. When Auto Advance is not selected, you must scroll manually from cell to cell after 
scanning in information by pressing the arrow buttons  
To toggle Auto Advance on or off, press , , or . A checkmark (�) is displayed when it is on. 
Right-to-Left Table 
Select Right-to-Left Table to change the direction of the table so that the first cell is in the upper right corner 
of the table and the table scrolls from right to left.  
To toggle the Right-to-Left Table option on or off, press , , or . A checkmark (�) is displayed when 
it is on. 
Note: This option appears only if you have at least one table file on your Pen.  
New File 
To create a new table file: 
1. Select New File. The Enter file name dialog box opens in Scan mode (the field is highlighted). 
2. Scan in a file name, or enter one manually. The Pen saves up to eight characters in the name. 

Notes: 
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• The file name field is initially in Scan mode. If you scan text, the first eight letters that you scan are 
inserted in the file name field and the OK button is highlighted. If you want to rescan the name or edit 
it manually, press  first to return to the file name field.  

• To manually enter the file name, press  once. The file name field will then be in Edit mode. Now 
you can press  again to access the Character Bar (see The Character Bar on page 67), or scan 
the Opticard key of the Opticard to activate the Opticard (see The Opticard on page 69), or press 
again to view the file name Edit Menu (this menu contains options specifically for editing file names, 
see The File Name Edit Menu on page 67). 

3. Select OK. 
4. A new file is created and the first cell appears in Scan mode. 
5. The file is now ready for editing. See Editing Tables on page 49 for information on editing tables. 
Open File 
To open an existing table file: 
1. Select Open File. A list of existing files appears. 
2. Select the file you want to open. 
3. The file is opened and the first cell appears in Scan mode. 
4. The file is now ready for editing. See Editing Tables on page 49 for information on editing tables. 
Delete File 
To delete an existing table file: 
1. Select Delete File. 
2. Select the file you want to delete. 
3. Select YES when the confirmation message appears. 
Exit 
Exits the Tables application and returns to the Pen Main Menu. 
 
The Tables Edit Menu 
The Edit Menu contains additional options which affect the editing of the current open file. 
Note: an additional Edit Menu is available from the Enter file name dialog box with options for editing the file 
name (see The File Name Edit Menu on page 67). 
Accessing the Edit Menu 
When in an open table (see Creating and Opening Tables on page 49), make sure you are in Edit mode (the 
cursor should be blinking, see Edit Mode on page 50) and press  once to access the Tables Edit Menu. 
Following is a description of the Edit Menu options: 
Resume Editing 
Select this option to close the Edit Menu and return to the table. 
Activate Overwrite Mode/Activate Insert Mode 
This toggle option is a general option relating to the usage of the Character Bar. For information on this 
option, see Insert Mode and Overwrite Mode on page 68 in ‘The Character Bar’ section of this manual. 
Clear Line 
Select this option to erase the current line in the current cell. 
Select Language 
Use this option to change the scanning language if the material you are scanning is in a different language. 
When the Scanning Language setting matches the language of the printed text, the scanning results are 
optimal, since a spelling check for that specific language is performed. 
Important: 
This setting affects the future scanning into the current file only. This may be useful when scanning different 
languages into one file. If you wish to change the general setting of the Pen, which will affect all new files 
created on the Pen, in all of the applications, then please change the scanning language in the Set Scanning 
Language option in the Settings menu of the Pen Main Menu (see Set Scanning Language on page 62). 
To select a scanning language: 
1. Access a new cell. Note: You cannot change the scanning language if text already exists in the current 

cell. Open a new cell before you change the scanning language. Otherwise, the Pen will ask you to delete 
the existing text. 

2. If the cell is in Scan mode (if the cell appears with a black background) press �to activate the Edit 
mode.  

3. When in Edit mode, press  to open the Edit Menu. 
4. Select the Select Language option. The current language appears highlighted. 
5. Select the language you want. 
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6. This setting affects future scanning into the current file only. Any new file created will be set to the 
scanning language that is set in the Set Scanning Language option in the Settings menu of the Pen 
Main Menu. 

Scanning Options 
Select the Scanning Options to temporarily change the scanning option for the next time you enter text into 
the current field. 
The following scanning options are available. You can select any or all of these settings. 
• Numeric: For a string of numbers.  
• Inverse: For light text on a dark background. 
• Multiple Lines: To store more than one line of text. When this option is selected, a new line is opened in 

the same field after each line is scanned. To continue to the next field you will need to press . 
Press , , or  to toggle an option on or off. A checkmark (�) is displayed when the option is on. Press 

 to close the Scanning Options, save your settings and return to the table you were editing. 
Insert Row 
Select this option to add a row to the open table file. The row is inserted above the current row. 
Insert Column 
Select this option to add a column to the open table file. The column is inserted before the current column. 
Remove Row 
Select this option to remove the current row from the open table file. 
Remove Column 
Select this option to remove the current column from the open table file. 
Insert Line 
Select this option to insert an additional line in the current cell, after the current line. 
Note: If the Multiple Lines scanning option is activated for this cell, you just need to scroll to the last line in 
the cell and press  in order to add a line. 
Delete Line 
Select this option to delete the current line from the cell. 

Creating and Opening Tables 
From the Tables main menu, select any of the following options: 
• Select Edit Current File to open the current file. The ‘current’ file is the one whose name appears in the 

caption of this menu. If no file is currently open, the message No Open File appears in the caption. In 
this case, selecting Edit Current File will first show the message No Open File and then show the Enter 
file name dialog box, suggesting a new file name. 

• Select New File to create a new file and then open it. The Enter file name screen will first appear 
suggesting a default file name. 

• Select Open File to select an existing file and open it. A list will first appear suggesting all available files. 
The file opens and the blinking cursor indicates the point at which text will be inserted. 

Editing Tables 
Easy Steps 
1. Create or open a file (see above). The tables cells appear in Scan mode (see How to know which mode 

the Pen is in on page 50) – meaning you can simply start scanning and the cell will accept the scanned 
text. Each table cell has a caption with a letter (starting with A and continuing with B, C, D, etc.), 
indicating the column in which the current cell is positioned and a number (starting with 1 and continuing 
with 2, 3, 4, etc.) indicating its row. 

2. Make sure the Pen screen displays the required cell; if not, scroll until it does. Then scan in the parallel 
cell from an English printout of a table, for example, if you wish to scan in the first cell of a table (top left 
cell), the Pen should display the A1 cell on its screen. Note: if you want to scan text that is in a different 
language, see Select Language on page 48. If you want to scan numeric or inverse text, or if you want a 
cell to contain more than one line, see Scanning Options on page 49. 

3. The new text appears in the cell and the new text is highlighted. 
4. If the scanning results on the screen are not satisfactory, you can edit the cell in various ways - see 

Editing Existing Text on page 50. 
5. Scroll to the next cell (scrolling to the right will proceed to the next cell in the same row, scrolling down will 

scroll to the next cell in the same column). 
6. Continue scanning the table cells. 
7. When done, press  (once if in Scan mode, 3 times if in Edit mode) to close the file and save your 

changes. The Tables main menu is displayed. 
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Editing Existing Text 
There are 2 modes for editing existing text – Scan mode and Edit Mode. The mode affects the editing of the 
current field (cell) - meaning you must currently be in an open field. 
Scan Mode 
This is the default mode in the Tables application. When the current field is in Scan mode, scanning new text 
will delete any text from the whole field (if existing) and replace it with the new text you have scanned. This is 
useful for rescanning the whole field. 
Edit Mode 
When the current field is in Edit mode, you can do any following: 
• Insert Text: scan new text you want to insert into the current field. Please scan whole words and not 

single characters (for single character editing, use the Character Bar or the Opticard). The new text is 
inserted where the cursor was positioned and spaces are added to create correct word separation within 
the line of text. To quickly undo this new scan, simply press . This will delete the new scan which 
initially appeared highlighted (it appeared highlighted to allow this quick undoing). If you do not want to 
undo the new scan, press the arrow buttons to de-highlight the text, before entering more text. 

• Use the Edit Menu: press  to access the Tables Edit Menu (see The Tables Edit Menu on page 48). 
• Use the Character Bar: press  to display the Character Bar (see The Character Bar on page 67) and 

edit the point at which the cursor is inserted. 
• Use the Opticard: scan the Opticard key to activate the Opticard (see The Opticard on page 69) and edit 

the point at which the cursor is inserted. 
How to know which mode the Pen is in 
• In Scan mode the whole field appears with a black background and all the text is green. There is no 

blinking cursor.  
• In Edit mode there is a blinking cursor in the current field.  
Switching between Scan mode and Edit mode 

• If you are in Scan mode (no blinking cursor, field background is black), press  to switch to Edit 
mode. 

• If you are in Edit mode (blinking cursor), press  twice to switch to Scan mode. 
Navigation Shortcuts 
Double-clicking the arrow buttons on the Pen quickly moves the cursor within the current cell (when the 
cursor is blinking - in Edit mode).  

Double-click 
this button 

To move the cursor to:  

 
The beginning of the cell 

 
The end of the cell 

Scanning in different Languages 
Please refer to Select Language on page 48. 
 

Closing and Saving Table Files 
When done editing a file, press  (once if in Scan mode, 3 times if in Edit mode) to close the table file and 
save your changes. The Tables main menu is displayed. 

Exiting the Tables Application 
To return to the Pen Main Menu, press  from the Tables main menu or select the Exit option at the 
bottom of it. 

Sending Stored Tables to the PC 
Important: 
The transferal of stored file info between the Pen and PC requires Pen-PC Communications. Therefore, you 
must have already run the one time procedure Set Up Product on PC from the QuickLink-Pen® Elite CD-
ROM. If you have not yet done this, please refer to Set Up Product on PC on page 8 and follow the 
instructions there. 
To send stored tables to the PC: 
1. Turn your PC on. 
2. Make sure that your Pen and PC are connected. Note: they should be connected in the same manner 

you had chosen during the Set Up Product on PC procedure of the QuickLink-Pen® Elite CD-ROM. For 
example, make sure that the USB plug side of the USB cable is connected to the USB outlet on your PC 
and that the other side of the cable is connected to the PC-Link Connector outlet of your Pen. 
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3. Start the QuickLink-Pen Elite Desktop application and make sure that Pen communications are on (see 
How to know if Pen Communications are on, page 58). 

4. Turn the Pen on. 
5. Long press  until you reach the Pen Main Menu. 

6. Press  until Send Stored Files to PC appears on the screen. 

7. Press . The sending begins. Note: When performing Send Stored Files to PC, all stored files (from 
all storing applications) on your Pen are sent to the PC, according to the Pen-PC File Transfer Settings 
set in the Desktop application (see Setting the File Transfer Settings on page 52). 

8. When the process is done, OK the pop up in the QuickLink-Pen Elite Desktop. 
9. Click the Tables icon in the QuickLink-Pen Elite Desktop application. 
10. The list of tables you had transferred from the Pen - appear on the screen. 
Note: By default, the stored files of the Tables application are copied from the Pen to the Desktop application 
and then deleted from the Pen. See File Transfer Settings for Tables on page 57 for information on changing 
these settings or having the files sent to additional PC applications such as MS Explorer. 
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Sending Stored Files to the PC 
The transferal of stored data is possible between the Pen and the PC (Desktop and Host applications). The 
send function is performed for any storing applications you have installed. The available storing applications 
in this product are the default Scan and Store and Image Capture applications, plus the 3 add-on 
applications: Address Book, Internet Links and Tables. All these applications store text, except for the 
Image Capture application, which stores images. The sending is performed according to the settings set in 
the Pen-PC File Transfer Settings dialog in the Desktop application. The sending is initiated by the Pen, 
while the PC is prepared to receive this initiation. 
Following are instructions for setting and performing the Send Stored Files to PC operation. 
 

Preparing the PC 
Important: 
The transferal of stored file info between the Pen and PC requires Pen-PC Communications. Therefore, you 
must have already run the one time procedure Set Up Product on PC from the QuickLink-Pen® Elite CD-
ROM. If you have not yet done this, please refer to Set Up Product on PC on page 8 and follow the 
instructions there. 

Starting the Desktop Application 
1. Turn your PC on. 
2. Important: Close any applications that are running on your computer. The icons of the applications that 

are running on your PC appear in the System Tray. It is especially important to close applications that use 
the serial port of your computer, such as PDAs or digital camera applications. 

3. Start the QuickLink-Pen Elite Desktop application: 
• If, during installation, you chose to add the Desktop to your computer’s startup, the Desktop will 

automatically start running when you start your computer, its window minimized. To reveal the 
Desktop window, click the Desktop icon ( ) in the system tray at the bottom of the screen. If the 
Desktop window does not appear, select the Show Window option from the pop-up menu. 

• If the Desktop application does not run when you start up your computer, or if you had closed the 
application, you can start it by opening the Windows Start menu and select Programs\QuickLink-
Pen Elite Desktop\QuickLink-Pen Elite Desktop.  

4. For more information on the Desktop application, please refer to the QuickLink-Pen Elite Desktop Help 
file. 

Setting the File Transfer Settings 
When the option Send Stored Files to PC is selected on the Pen a transferal of files occurs between the 
Pen and PC. The settings for this transferal are set in the Pen-PC File Transfer Settings dialog in the 
Desktop. The dialog is preset to the default settings. 
If the following default settings suit your needs, you need not perform any of the procedures in this section - 
you can continue to the next section - Confirming Pen-PC Communications on page 58. 
The Default Settings 
Following are the default settings for each of the storing applications, as set in the Pen-PC File Transfer 
Settings dialog in the Desktop: 
Note: The following list includes information for the add-on applications, which you may not have included in 
your product. If you wish to include any one of them, see Installing Add-On Applications on page 35. 
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Scan and Store: 
The stored text files of the Scan and Store application are copied from the Pen to the Desktop application 
and then deleted from the Pen (“flushed”). 
Image Capture 
The stored image files of the Image Capture application are copied from the Pen to the Desktop application 
and then deleted from the Pen (“flushed”). 
Address Book (add-on) 
All addresses from the main Address Book (mainadd) – both those stored in the Pen and those created or 
modified in the Desktop - are synchronized, resulting in one Address Book file (mainadd), identical on the 
Pen and on the Desktop.  
Internet Links (add-on) 
All links from the main Internet Links file (mainlnk) – both those stored in the Pen and those created or 
modified in the Desktop - are synchronized, resulting in one Internet Links file (mainlnk), identical on the Pen 
and on the Desktop.  
Tables (add-on) 
The stored table files of the Tables application are copied from the Pen to the Desktop application and then 
deleted from the Pen (“flushed”). 
If you wish to change any of these default settings – see the following instructions. 
The Pen-PC File Transfer Settings Dialog 
Accessing the Dialog 
In the Desktop application select Pen Communications from the menu bar and then select the Pen-PC File 
Transfer Settings … option. The Pen-PC File Transfer Settings dialog opens, displaying the current file 
transfer settings for each of the applications installed in the Desktop. 

 
The Pen-PC File Transfer Settings dialog 

 
The Application Settings 
The Pen-PC File Transfer Settings dialog displays each storing application installed in your product and its 
current settings for the Send Stored Files to PC transfer. This information is displayed in the middle area of 
the dialog in a 4 column table. Following is a description of each column: 
Application 
Each row displays a different storing application which you have installed on your Pen and PC. 
Mode 
This is what will be done with the application files on the Pen and PC when performing the Send Stored 
Files to PC operation. 
Flush 
When on, this column says Yes and the application files are deleted from the Pen at the end of the Send 
Stored Files to PC operation.  
When off, this column says No and the application files on the Pen are not deleted. 
Host Application 
If a host application is set, its name will appear here; if none is set, None will appear.  
A host application is a PC application – other than the QuickLink-Pen Elite Desktop application – to which 
the stored files can also be transferred. This way you can view the sent stored data in these applications, in 
addition to viewing it in the Desktop application. See Activating Host Settings on page 54 for information on 
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activating the possibility of involving Host Applications in the send process, since, by default, this feature is 
turned off. 
Pen Name 
The name of the current Pen Name (the one whose data is currently displayed in the Desktop) is displayed in 
the Desktop bar. The Pen-PC File Transfer Settings dialog displays the setting for one “Pen Name”. When 
launching the Pen-PC File Transfer Settings dialog, the settings of the current Pen Name are displayed and 
its name appears again in the top left of the Pen-PC File Transfer Settings dialog. 
The Pen Name is a profile used in the Desktop for storing the data of one scanning device. When performing 
Pen-PC communications, such as Send Stored Files to PC, the Desktop matches the scanning device with 
its associated Pen Name, so that the data of one Pen is always stored in the associated Pen Name profile.  
Important: The Pen Name mechanism is for advanced users only, or users that own more than one actual 

scanning device. 
 

If you have one scanning device - it is highly advised to work with the default Pen Name “MyPen” – only. 
Activating Host Settings 
If you want the Pen to perform the Send Stored Files to PC with host applications, click the This Pen Name 
will Send Stored Files to host applications checkbox. Default host settings are set for each application 
and the Host Settings button is activated, allowing access to the Host Settings dialog. 
Note: Only one Pen Name can be designated at a time to interact with host applications. Again, as noted 
before, it is advised to work with the default Pen Name “MyPen”.  
The Default Host Settings 
The default host settings for each application are as following: 
• MS Word as the host for Scan and Store. 
• MS Outlook as the host for the Address Book. 
• MS Internet Explorer as the host for the Internet Explorer. 
• MS Excel as the host for Tables. 
• Note: there is no host application for the Image Capture application. 
Important: Any host applications you have set must be fully installed and functional on your PC, or else the 

Send Stored Files to PC function will fail. 
If you want to cancel the interaction of this product with host applications, simply uncheck This Pen Name 

will Send Stored Files to host applications checkbox. 
If you want to turn off the host interaction for some of the storing applications, but leave it on for others, 

refer to the explanation about the Host Application column, of the Host Settings dialog, on page 55. 
The Host Settings Dialog 
To change the host settings you have set, select the Host Settings button on the Pen-PC File Transfer 
Settings dialog to display the Host Settings child dialog. 
Note: if the Host Settings button is inactive, see Activating Host Settings on page 54 for information on 
activating it.  

 
The dialog box displays a 4 column table in which the storing applications on your Pen and their host settings 
are listed.  
 
Following is a description of each column: 
Application 
Each row displays a different storing application which you have installed on your Pen and PC (this should be 
the same list viewed in the Pen-PC File Transfer Settings father dialog). 
Pen File 
The file(s) from each storing application that can be transferred to or from the host application, when 
performing the Send Stored Files to PC operation, are as follows: 
• Scan and Store: All Scan and Store files (*.qnt) are transferred to the host application. 
• Address Book: All addresses in the main Address Book file, mainadd.qad, are transferred to and/or 

from the host application. 
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• Internet Links: All links in the main Internet Links file, mainlnk.qlk, are transferred to and/or from the 
files in the specified folder of the host application. 

• Tables: All Tables files (*.qtb) are transferred to the host application. 
Host Application 
The current host application set for the application. This option contains a list of available hosts for each 
application, plus the option None. Use the None option to turn off host application interaction for a specific 
application. 
Host Folder 
The folder in which the host application files, that are created or updated during the Send Stored Files to PC 
process, are stored. 
Note: Files sent, with a host application set, are placed in the folder specified in the Host Folder column, as 
well as in the QuickLink-Pen Elite Desktop installation folder. 
Show this dialog before each Send Stored Files to PC 
At the bottom of the Pen-PC File Transfer Settings dialog is a Show this dialog before each file transfer 
check box. Checked is on, not checked is off (the default). Click the option to toggle the check mark. When 
this option is on, this dialog will appear right after selecting the Send Stored Files to PC on the Pen, prior to 
actually starting the process. This way you can confirm that the settings are satisfactory. If they are not 
satisfactory, you can change them. When done, press Proceed from the Pen-PC File Transfer Settings 
dialog, to continue the send process, or press Close to stop the process. 
Following are instructions on changing the Pen-PC File Transfer Settings and/or the Host Settings for each 
of the storing applications. 
File Transfer Settings for Scan and Store 
The Send Stored Files to PC operation is performed according to the settings set in the Pen-PC File 
Transfer Settings dialog (and its child dialog Host Settings).  
Changing the Mode or Flush Settings 
1. Access the Pen-PC File Transfer Settings dialog. 
2. Select the Scan and Store row from the table. 
3. Click on the Change button. 
4. The Change Pen-PC File Transfer Settings dialog appears. 
5. From the Transfer Mode section, click on the desired mode to activate its radio button: 

• Pen to PC (the default) will set that the stored text files from your Pen will be copied from the Pen to 
the PC. 

• Don’t send the stored files of this application – when selecting this option, the Send Stored Files 
to PC does not include the Scan and Store application, or its files and no changes are performed - 
not on the Pen nor in the PC (Desktop or Host Applications). 

6. In the right side of the Change Pen-PC File Transfer Settings dialog, click on the Flush check box to 
set the Flush mode. Checked is on (the default), not checked is off. When on, this option will cause the 
Scan and Store files on the Pen to be deleted after they are sent to the PC when performing Send 
Stored Files to PC. 

Changing the Host Application Settings 
1. Make sure that the This Pen Name will Send Stored Files to host applications check box on the Pen-

PC File Transfer Settings dialog is checked and click the Host Settings button. Note: if the Host 
Settings button is inactive, see Activating Host Settings on page 54 for information on activating it. 

2. The Host Settings dialog appears. 
3. Select the Scan and Store row from the table. 
4. Click on the application name field (under the Host Application column). 
5. Choose the desired setting from the list that opens: 

• Word – the stored pen files of this application are converted to .doc format and placed in the folder 
specified in the Host Folder column. You can access this folder with MS Explorer and double-click 
any of the files. The files will open in MS Word (if installed on your PC). 

•••• Outlook– the stored pen files of this application are converted to the Outlook Notes format and placed 
in the MS Outlook Notes folder, as specified in the Host Folder column. 

•••• None – select this option to cancel any host interaction with the Scan and Store application. 
6. Click OK to save changes and close the Host Settings dialog. Click Cancel to disregard any settings 

you have just changed. 
File Transfer Settings for Image Capture 
The Send Stored Files to PC operation is performed according to the settings set in the Pen-PC File 
Transfer Settings dialog (and its child dialog Host Settings).  
Changing the Mode or Flush Settings 
1. Access the Pen-PC File Transfer Settings dialog. 
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2. Select the Image Capture row from the table. 
3. Click on the Change button. 
4. The Change Pen-PC File Transfer Settings dialog appears. 
5. From the Transfer Mode section, click on the desired mode to activate its radio button: 

• Pen to PC (the default) will result in the stored image files from your Pen being copied from the Pen to 
the Desktop. 

• Don’t send the stored files of this application – when selecting this option, the Send Stored Files 
to PC does not include the Image Capture application, or its files and no changes are performed - not 
on the Pen, nor in the Desktop. 

6. In the right side of the Change Pen-PC File Transfer Settings dialog, click on the Flush check box to 
set the Flush mode. Checked is on (the default), not checked is off. When on, this option will cause the 
Image Capture files on the Pen to be deleted after they are sent to the Desktop, when performing Send 
Stored Files to PC. 

Changing the Host Application Settings 
There are no host applications for this application. The .bmp files from the Pen are transferred and displayed 
in the Desktop. Click on the file name once to display it in the Desktop window, double-click on the file name 
to open it in the graphic editor or viewer you have associated .bmp files with, in the Windows settings of your 
PC. 
File Transfer Settings for Address Book 
Important: This is an add-on application that is not included in your default product. To use it, you must first 
add it to your Pen and Desktop application, using the CD-ROM (see Installing Add-On Applications on page 
35). 
The Send Stored Files to PC operation is performed according to the settings set in the Pen-PC File 
Transfer Settings dialog (and its child dialog Host Settings).  
Changing the Mode or Flush Settings 
1. Access the Pen-PC File Transfer Settings dialog. 
2. Select the Address Book row from the table. 
3. Click on the Change button. 
4. The Change Pen-PC File Transfer Settings dialog appears. 
5. From the Transfer Mode section, click on the desired mode to activate its radio button: 

• Synchronize Pen and PC (the default) - all addresses from the main Address Book (mainadd) – 
those stored in the Pen and those created or modified in the PC (Desktop and Host Application) - are 
synchronized - resulting in one Address Book file (mainadd), identical on the Pen, on the Desktop 
and in the Host application (if one is set). 

• PC to Pen will result in the address book files, existing in the Address Book application of the 
Desktop, being copied to the Pen (overwriting the ones on the Pen). 

• Don’t send the stored files of this application – when selecting this option, the Send Stored Files 
to PC does not include the Address Book application, or its files and no changes are performed - not 
on the Pen, nor in the PC (Desktop or Host Applications). 

6. In the right side of the Change Pen-PC File Transfer Settings dialog, click on the Flush check box to 
set the Flush mode. Checked is on, not checked is off (the default). When on, this option will cause the 
Address Book files on the Pen to be deleted after they are sent to the PC, when performing Send 
Stored Files to PC. 

Changing the Host Application Settings 
1. Make sure that the This Pen Name will Send Stored Files to host applications check box on the Pen-

PC File Transfer Settings dialog is checked and click the Host Settings button. Note: if the Host 
Settings button is inactive, see Activating Host Settings on page 54 for information on activating it.  

2. The Host Settings dialog appears. 
3. Select the Address Book row from the table. 
4. Click on the application name field (under the Host Application column). 
5. Choose the desired setting from the list that opens: 

•••• Outlook– the addresses from the mainadd file are converted to the Outlook Contacts format and 
placed in the MS Outlook Contacts folder, as specified in the Host Folder column. 

•••• None – select this option to cancel any host interaction with the Address Book application. 
6. Click OK to save changes and close the Host Settings dialog. Click Cancel to disregard any settings 

you have just changed. 
File Transfer Settings for Internet Links 
Important: This is an add-on application that is not included in your default product. To use it, you must first 
add it to your Pen Desktop application, using the CD-ROM (see Installing Add-On Applications on page 35).  
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Changing the Mode or Flush Settings 
1. Access the Pen-PC File Transfer Settings dialog. 
2. Select the Internet Links row from the table. 
3. Click on the Change button. 
4. The Change Pen-PC File Transfer Settings dialog appears. 
5. From the Transfer Mode section, click on the desired mode to activate its radio button: 

• Synchronize Pen and PC (the default) - all links from the main Internet Links file (mainlnk), those 
stored in the Pen and those created or modified in the PC (Desktop and Host Application) - are 
synchronized - resulting in one Internet Links file (mainlnk), identical on the Pen, on the Desktop and 
in the Host application (if one is set). 

• PC to Pen will result in the internet links files, existing in the Internet Links application of the 
Desktop, being copied to the Pen (overwriting the ones on the Pen). 

• Don’t send the stored files of this application – when selecting this option, the Send Stored Files 
to PC does not include the Internet Links application, or its files and no changes are performed - not 
on the Pen, nor in the PC (Desktop or Host Applications). 

6. In the right side of the Change Pen-PC File Transfer Settings dialog, click on the Flush check box to 
set the Flush mode. Checked is on, not checked is off (the default). When on, this option will cause the 
Internet Links files on the Pen to be deleted after they are sent to the PC, when performing Send 
Stored Files to PC. 

Changing the Host Application Settings 
1. Make sure that the This Pen Name will Send Stored Files to host applications check box on the Pen-

PC File Transfer Settings dialog is checked and click the Host Settings button. Note: if the Host 
Settings button is inactive, see Activating Host Settings on page 54 for information on activating it.  

2. The Host Settings dialog appears. 
3. Select the Internet Links row from the table. 
4. Click on the application name field (under the Host Application column). 
5. Choose the desired setting from the list that opens: 

•••• Internet Explorer – the links from the mainlnk file are placed in the Favorites folder of MS Internet 
Explorer, under a sub folder, as specified in the Host Folder column. 

•••• Netscape – the links from the mainlnk file are converted into Netscape Bookmarks, under a sub 
folder, as specified in the Host Folder column. Note: If you select Netscape and Netscape has more 
than one user profile, you are prompted to select the Netscape user profile under which you would like 
your links to be saved as bookmarks. Netscape must be updated to its latest version in order to be 
compatible with the Pen. 

•••• None – select this option to cancel any host interaction with the Internet Links application. 
6. Click OK to save changes and close the Host Settings dialog. Click Cancel to disregard any settings 

you have just changed. 
File Transfer Settings for Tables 
Important: This is an add-on application that is not included in your default product. To use it, you must first 
add it to your Pen and Desktop application, using the CD-ROM (see Installing Add-On Applications on page 
35). 
The Send Stored Files to PC operation is performed according to the settings set in the Pen-PC File 
Transfer Settings dialog (and its child dialog Host Settings).  
Changing the Mode or Flush Settings 
1. Access the Pen-PC File Transfer Settings dialog. 
2. Select the Tables row from the table. 
3. Click on the Change button. 
4. The Change Pen-PC File Transfer Settings dialog appears. 
5. From the Transfer Mode section, click on the desired mode to activate its radio button: 

• Pen to PC (the default) will result in the stored table files from your Pen, being copied from the Pen to 
the PC. 

• Don’t send the stored files of this application – when selecting this option, the Send Stored Files 
to PC does not include the Tables application, or its files and no changes are performed - not on the 
Pen, nor in the PC (Desktop or Host Applications). 

6. In the right side of the Change Pen-PC File Transfer Settings dialog, click on the Flush check box to 
set the Flush mode. Checked is on (the default), not checked is off. When on, this option will cause the 
Tables files on the Pen to be deleted after they are sent to the PC, when performing Send Stored Files 
to PC. 
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Changing the Host Application Settings 
1. Make sure that the This Pen Name will Send Stored Files to host applications check box on the Pen-

PC File Transfer Settings dialog is checked and click the Host Settings button. Note: if the Host 
Settings button is inactive, see Activating Host Settings on page 54 for information on activating it.  

2. The Host Settings dialog appears. 
3. Select the Tables row from the table. 
4. Click on the application name field (under the Host Application column). 
5. Choose the desired setting from the list that opens: 

•••• Excel – the stored pen files of this application are converted to .xls format and placed in the folder 
specified in the Host Folder column. You can access this folder using MS Explorer and double-click 
any of the files. The files will open in MS Excel. 

•••• None – select this option to cancel any host interaction with the Scan and Store application. 
6. Click OK to save the changes and close the Host Settings dialog. Click Cancel to disregard any settings 

you have just changed. 

Confirming Pen-PC Communications 
1. Connect the Pen to the PC. Make sure the connection is done in the same manner you had chosen 

during the Set Up Product on PC procedure of the QuickLink-Pen® Elite CD-ROM. For example, make 
sure that the USB plug side of the USB cable is connected to the USB outlet on your PC and that the 
other side of the cable is connected to the PC-Link Connector outlet of your Pen. 

2. In the Desktop application, make sure that the Pen Communications are ON (this is the default). 
How to know if Pen Communications are on 
To find this out, simply confirm that the Pen Communications icon in the Desktop is pressed 

( ) and that the first option in the Pen Communications menu in the Desktop bar is 
Turn Pen Communications off. If the option says Turn Pen Communications On, select this 
option to turn the Pen Communications on. 

• The Desktop cannot detect communications from the Pen when Pen Communications are off, 
when the Pen is not connected properly, or when the necessary software is not working. 

• When Pen communications are on, the communications port is busy (you can see which one in 
the Communications Settings dialog of the Desktop). You cannot use this port 
simultaneously for any other purpose unless you exit the Desktop application. 

3. If you fail to set the Pen Communications on, rerun the Set Up Product on PC procedure from the CD-
ROM. This may fix the problem. If not, feel free to contact our Support Team (see Contact and Support 
Information on page 6).  

 

Sending the Stored Files 
1. Turn the Pen on.  
2. Long press  until you reach the Pen Main Menu. 

3. Press  until Send Stored Files to PC appears on the screen. 

4. Press . The sending process begins – the Pen displays Sending… and the PC shows a box with 
flying papers. If the process does not begin or the Pen reports Sending… Connection failed, please 
refer to Confirming Pen-PC Communications on page 58. 

5. When the process is done, OK the pop up in the QuickLink-Pen Elite Desktop. 
6. The data of the applications appears in the Pen, Desktop and Host applications – all according to the 

settings you have set in the Pen-PC File Transfer Settings dialog (see Setting the File Transfer Settings 
on page 52). 

 

Viewing and Editing on the PC 
1. Start the Desktop application (See Starting the Desktop Application on page 52). 
2. Confirm that the desired Pen Name is the current one, so that its files are displayed in the Desktop. The 

current Pen Name is displayed in the desktop icon bar, for example: 

 
Note: The Pen Name is a profile used in the Desktop for storing the data of one scanning device. So, if 
you own one scanning device, it is highly advised to work with only one Pen Name – the default Pen 
Name “MyPen”. 

3. Click on the icon of the desired application, from the left pane of the Desktop. 
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• When selecting the Scan and Store, Image Capture or Tables applications (Note: Tables is an add-
on application), the Desktop window displays 2 panes: 

• the middle pane displays the list of all the files of this application. 
• The right pane displays the entries from one file – the one selected from the middle pane. 

• When selecting the Address Book or Internet Links applications (Note: these are add-on 
applications), the desktop displays one file - the main file (mainadd for Address Book and mainlnk for 
Internet Links) in the right pane (there is no middle pane). Each line on the screen is a record from 
the open file (an address entry or link entry). 
Note: though it is advised to work in these applications (both on the Pen and in the Desktop) – while 
using the main files only (since only they fully support all features of these applications) - you can 
create or open other files, using the Desktop File menu. 

4. The data displayed for each application is the data that has been sent from the Pen (using the Send 
Stored Files to PC), data that has been created in the Desktop, or data that has been synchronized from 
host applications. See The Pen-PC File Transfer Settings Dialog on page 53 for more information on 
what happens to the Pen and PC data when performing Send Stored Files to PC. 

5. Within each application, you can create and edit files and entries, using the various options in the 
Desktop File menu, or using the specific application options, which are available when right-clicking the 
mouse on a selected file (from the file list in the middle pane) or on a selected entry (from the right pane). 
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The Scan to PC Application 
The Scan to PC application enables you to scan printed text directly into a Windows application on your 
computer. The Pen enters the scanned text where the cursor appears in the active application on your 
computer.  

Preparing the PC 
Important: 
The transferal of stored file info between the Pen and PC requires Pen-PC Communications. Therefore, you 
must have already run the one time procedure Set Up Product on PC from the QuickLink-Pen® Elite CD-
ROM. If you have not yet done this, please refer to Set Up Product on PC on page 8 and follow the 
instructions there. 

Starting the Desktop Application 
See Starting the Desktop Application on page 52, then return to here and proceed. 

Scan to PC Settings in the Desktop 
The Scan to PC Settings in the Desktop are already preset to the default, which will insert a space after 
each scan. If this default setting suits your needs, you need not perform any of the procedures in this section 
and you can continue to the next section Confirming Pen-PC Communications, page 60. 
Accessing the Scan to PC Settings Dialog 
In the Desktop application select Pen Communications from the menu bar then select the Scan to PC 
Settings… option. The Scan to PC Settings dialog opens, displaying the current setting: 

 
 
Using the Scan to PC Settings Dialog 
The Scan to PC Settings dialog displays what will be inserted after each scanned line that is scanned and 
sent to the open application. 
From the Scan to PC Settings dialog, select the desired option, then click OK to close the dialog and save 
any changes. The available options are:  
• Space - inserts a space after each scan.  
• Tab - inserts a tab after each scan. (This is useful, for example, when you are scanning into an Excel 

table. When you finish scanning, the cursor automatically jumps to the next cell.) 
• Enter - The cursor moves to the next line after each scan (opens a new paragraph). 
• Nothing - Nothing is inserted after each scan. The next scan continues immediately after the last 

character of the previous scan. 

Confirming Pen-PC Communications 
Refer to Confirming Pen-PC Communications on pages 58-58 then return to here and proceed. 
 

Preparing the PC Application 
Open the target application on your PC; make sure its window is the active window on your computer (click 
the window with your mouse) and that the cursor is blinking (if not, you may need to open a file for editing, 
depending on the application). 
 

Scanning Text to the PC 
1. Turn the Pen on.  
2. Long press  until you reach the Pen Main Menu. 

3. Press  until Scan to PC appears on the screen. 

4. Press . The Scan Now window appears with a blinking cursor. You are now ready to scan. 
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5. Scan printed English text. To scan other types of text (numeric, inverse, or non-English): 
a. If you are scanning numeric (all digits) and/or inverse text (light text on dark background), please set 

the Pen as follows: 
i. From the Scan Now window, press  to open the Options menu. 
ii. Select Scanning Options. 
iii. Press , , or  to toggle an option on or off. A checkmark (�) is displayed when the option 

is on. 
iv. Press  to close the Scanning Options, save your settings and return to Scan Now window. 

Small icons at the top right corner of the screen indicate the current settings (  and/or ). 
v. These settings remain as is, until you change them. 
vi. Scan. Make sure you are scanning the appropriate type of printed text (numeric and/or inverse) – 

according to what you had set, or else the scanning results will be incorrect. 
b. If you wish to scan non-English text: 

i. From the Scan Now window, press  to open the Options menu. 
ii. Select the Select Language option. 
iii. Select the language which is the same as the language of the printed text you are scanning.  
iv. This setting remains as is, until you change it. This setting affects the future scanning with Scan 

to PC only. If you wish to change the general setting of the Pen, which will affect all new files 
created on the Pen, in all of the applications, then please change the scanning language in the 
Set Scanning Language option in the Settings menu of the Pen Main Menu (see Set Scanning 
Language on page 62). 

v. Scan. Make sure you are scanning printed text in the right language. When the Scanning 
Language setting matches the language of the printed text, the scanning results are optimal, since 
a spelling check for that specific language is performed. 

6. The Pen displays Sending… and the text you had scanned should appear, at the cursor point, in the PC 
application you have prepared (see Preparing the PC Application on page 60). If this does not happen, or 
the Pen displays the error message Error sending data to PC, please refer to Confirming Pen-PC 
Communications on page 60. 

7. Continue scanning. Each new scan will appear at the cursor point, plus a space, tab, new line – or 
nothing – according to what you have set in the Scan To PC Settings dialog in the Desktop (see Scan to 
PC Settings in the Desktop on page 60). The text you scan is entered into the application on the 
computer just as if it were being typed in with a keyboard. Highlighted text is overwritten. Text is inserted 
in Insert mode or overwritten in Overwrite mode. 

Note: Scan to PC does not interfere with your regular use of the application on your computer. You can input 
text with your keyboard and use all of the other features of the application while Scan to PC is active. 
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The Settings Menu 
Through the Settings menu, you can access screens, from which you can change the behavior of various 
Pen features. These features are already set to a default, which represents the most common settings. To 
change any of the settings, follow the instructions in this chapter. 

Accessing the Settings Menu 
1. Long press  until you reach the Pen Main Menu. 

2. Press  until Settings appears on the screen. 

3. Press  to enter the Settings menu. 
Following are descriptions of all the available settings in the Settings menu - what they do and how to set 
them. 
Important: 
When exiting any of the following setting screens, the  button will activate what you have just set, 
whereas  will close the screen without performing any change. 

 Voice Settings 
 

The Voice Settings menu contains options for controlling the way words are read aloud by the Pen. 
Note: Only English texts - scanned when the Scanning Language is set to English – can be read aloud. 
The Pen reads words out loud through its built-in speaker, or through the earphones included in the package. 
You can adjust the volume, pitch and speed of the reading voice to suit your specific needs. (Important: 
please lower the volume control before using the earphones to prevent ear irritation). 
Accessing the Voice Settings menu: 
From the Settings menu, scroll until the option Voice Settings appears on the screen and press .  
The following options are available in the Voice Settings sub menu: 

 Set Volume 
Use this option to adjust the volume level of the speaker. 
1. In the Voice Settings menu, scroll using  and  until the option Set Volume appears on the 

screen and press . 

2. The adjustment bar appears; adjust the volume level to the setting you want, using  or . 
3. Press . 

 Set Pitch 
 

Use this option to adjust the pitch of the speaker. 
1. In the Voice Settings menu, scroll using  and  until the option Set Pitch appears on the 

screen and press . 
2. Scroll to the pitch you want by using  or . The higher the number, the higher the pitch. 
3. Press . 

 Set Reading 
Speed  

This option enables you to adjust the speed at which the words are spoken out loud by the Pen. 
1. In the Voice Settings menu, scroll using  and  until the option Set Reading Speed 

appears on the screen and press . 
2. Scroll to the speed you want by using  or . The higher the number, the faster the speed. 
3. Press . 

 Set Scanning 
Language 

The scanning language should be set to the same language as the printed text you wish to scan. 
1. In the Settings menu, scroll using  and  until the option Set Scanning Language appears on the 

screen and press . 
2. Scroll to the language you prefer by using  or . 
3. Press . 
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Important:  
o Mismatch between the language set in the Scanning Language settings and the language of the 

scanned text, will produce poor scanning results. 
o Only texts scanned when the scanning language is set to English – can be read aloud. 

 Set Interface 
Language 

The interface language is the language in which the menus and messages appear. 
1. In the Settings menu, scroll using  and  until the option Set Interface Language appears on the 

screen and press . 
2. Scroll to the language you prefer by using  or . 
3. Press . 

 Communications 
Settings 

The Communications Settings contains the settings which are used for the Pen-PC Communications. The 
type of communications used are either Serial communications – in which case the USB cable provided in 
your package is used, or by Infra-Red communications, if you use an Infra-Red device. 
Important: 
It is not advised to change these settings on your own. Only change them if so instructed by one of the 
Wizards provided in your CD-ROM or in the Desktop application.  
To setup Pen-PC communications, please do one of the following: 
• To setup serial Pen-PC Communications - using the USB cable provided in your package: 

Please perform the procedures provided in the Set Up Product on PC option of your CD-ROM. 
• To setup Infra-Red Pen-PC Communications: 

Please run setup.exe from the CD-ROM folder Advanced Tools\Infra-Red Pen-PC Communications. 
Following is a description of the Communications Settings menu, though, as mentioned above, it is not 
advised to attempt setting these options on your own. 
Accessing the Communications Settings menu: 
From the Settings menu scroll until the option Communications Settings appears on the screen and press 

.  
The following options are available in the Communications Settings sub menu: 

 Set Comm. 
Device 

Use this option to set the communications device you plan to use. 
• Cable (used for serial communications) is the default and should be set when communicating 

via the USB cable provided in your package. 
• Infra-Red device should be chosen if you have an internal Infra-Red (IR) device or if you use a 

cable that converts serial communications to Infra-Red. The supported Infra-Red drivers are: 
ACT-IR220L, ADAPTEC, CRYSTAL, ESI, PARALLAX.  

1. In the Communications Settings menu, scroll using  and  until the option Set Comm. 
Device appears on the screen and press . 

2. Select the device you use, using  or . 
3. Press . 
Note: The setting here should match the setting specified in the Communications Settings dialog in 
the QuickLink-Pen Elite Desktop application. 

 Set Baud Rate 
 

Use this option to adjust the speed at which the Pen-PC communications are performed. The default 
baud rate setting is 115,200. 
1. In the Communications Settings menu, scroll using  and  until the option Set Baud Rate 

appears on the screen and press . 
2. Scroll to the baud rate you want by using  or . 
3. Press . 
Notes: 
• The setting here should match the setting specified in the Communications Settings dialog in 

the QuickLink-Pen Elite Desktop application. 
• It is recommended that the baud rate should also be the same in the computer settings. Usually 

these settings can be found under Start/Control Panel/System/Device 
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Manager/Communications Port/Port Settings. Change the Flow Control to Hardware as 
well. 

 Set Auto 
Shut-Off Time  

The Pen automatically shuts off after 2 minutes, if you do not scan or press any key. Use this option to 
change the automatic shut-off time. 
1. In the Settings menu, scroll using  and  until the option Set Auto Shut-Off Time appears on the 

screen and press . 
2. Change the automatic shut-off time, using  or . 

Note: The OFF setting will avoid the Pen from automatically shutting off. Please use the OFF setting with 
care - if the Pen is forgotten on, the batteries may run out. 

3. Press . 
 

 Set Right/Left 
Handed  

Use this option to switch between right and left-handed modes. Switching between these modes rotates the 
text on the display by 180º. The default is set to right-handed scanning. To change the setting: 
1. In the Settings menu, scroll using  and  until the option Set Right-/Left-Handed appears on the 

screen and press . 
2. Scroll to the mode you prefer by using  or . 
3. Press . 

 Set Contrast 
Use this option to adjust the brightness of the display. 
1. In the Settings menu, scroll using  and  until the option Set Contrast appears on the screen and 

press . 
2. The adjustment bar appears; adjust the contrast, using  or . The higher the number, the darker the 

display. Press . 
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The Information Menu 
The Information menu has a number of options that display information about your Pen. 
 

Accessing the Information Menu 
1. Long press  until you reach the Pen Main Menu. 

2. Press  until Information appears on the screen. 

3. Press  to enter the Information menu. 
Following are descriptions of all the available options in the Information menu. 

 View Battery 
Status 

In the Information menu, select this option to check how much power is left in the batteries. A diagram 
displays the power level. 

 View Memory 
Status 

In the Information menu, select this option to view the amount of flash memory available on your Pen. Press 
 to view the amount of compactable memory space (see Compact Memory below). 

  Compact 
Memory 

In the Information menu, select this option to compact the space the Pen components use on the Pen’s 
flash memory card, thus maximizing the amount of free space.  
Important: 

• Do not attempt to cancel the compact procedure (do not press ), or else the flash card will be 
damaged! Please wait until the process completes on its own. 

• Please see Compact on page 72 for information on compacting the Pen memory through the PC 
dialog Add\Remove Pen Components. 

• Please see Optimize Pen File System on page 73 for information on the Desktop option that 
compacts the space that the data and image files use on the Pen’s flash memory card. 

 View Serial 
Number 

In the Information menu, select this option to view the serial number of the Pen.  
 About 

In the Information menu, select this option to view information about the Pen software, the dictionary and the 
text-to-speech software (used to read the words aloud). 
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General Tools and Options 
 

Beaming Stored Data Files to a PDA 
Beaming allows to send stored data directly to an IrOBEX-compliant device like a PDA or a Smartphone, or 
to receive data from such a device and then save that data on your Pen. 
Note: Though the Beaming functions use Infra-Red communications, the Communications Settings are not 
used for these functions and you need not set them. 
 
Please refer to Beaming on pages 26 and 38 for instructions on using the Beaming feature in the Scan and 
Store and Address Book applications. 
 

The Pen Scanning Language 
The scanning language defines the language of the spelling check that is performed on the scanned text. 
Performing a spelling check on the scanning results obviously improves the basic character recognition 
drastically, forming real words out of letters. 
 
The Scanning Language setting should match the language of the printed text you are scanning, to direct the 
Pen as to which language speller should be used. 
 

Adding Scanning Languages 
If you scan printed texts in languages other than English, French, German or Spanish, you can add a 
Scanning Language for each additional language you wish to scan in. The QuickLink-Pen® Elite CD-ROM 
contains the following scanning languages which you can add to your Pen (in addition to English, French, 
Spanish and German – already installed): 
Swedish, Italian and Portuguese. 
 
To add a Scanning Language to your Pen: 
1. Insert the QuickLink-Pen® Elite CD-ROM into the CD-ROM drive of your computer. 
2. The Menu appears. 

Note: If the Menu does not appear automatically, please do the following:  
a. Click the Windows Start button and select Run. 
b. Type x: \setup.exe (where ‘x’ is your CD-ROM drive letter), then click OK. 

3. Click on the Install Add-Ons button. The Install Add-Ons menu appears 
4. Click on the Scanning Languages (for Pen) and follow the online instructions. 
The list of available scanning languages appears in the Set Scanning Language option (in the Settings 
menu of the Pen Main Menu) and in Select Language options (in the various Edit Menus of the 
applications). 

Changing the Scanning Language 
The Scanning Language setting must match the language you wish to scan in. 
The Scanning Language can be set in the general Set Scanning Language option, or in the Select 
Language option in the Edit Menu of the current file you are editing, within one of the Pen applications. 
Following are instructions for these settings. 

The General Pen Scanning Language 
The Set Scanning Language option in the Pen Main Menu affects scanning and editing in all text scanning 
applications. When changing this setting, it does not affect existing texts already stored on the Pen – it just 
affects any new texts that you are to scan from this point on. 
This option is general and is overridden by the scanning language setting within each application (if those are 
set differently). For more information on the language settings within the applications, see the following 
section The Application Scanning Language on page 67. 
Setting it 
To change the general Pen scanning language, see Set Scanning Language on page 62. 
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The Application Scanning Language 
Each text storing or scanning application contains an option for manipulating the scanning language within 
the currently edited field or file. These options affect the next scan or all next scans into the specific 
application and do not modify previously stored text.  
Setting it 
Following are references to the sections with information regarding the options for changing the scanning 
language within each text scanning application: 
• Scan and Store – see Select Language on page 26. 
• Address Book – see Next Address Lang. on page 37 
• Internet Links – see Next Link Language on page 43. 
• Tables – see Select Language on page 48. 
• Scan to PC – see list item �5-�b in Scanning Text to the PC on page 60 

The File Name Edit Menu 
This menu has options that affect the editing of file names when creating new files in the various Pen 
applications. 
Note: this menu is different than the Edit Menus appearing within the Pen applications, containing various 
options for editing of the actual application files (and not just file names). 
Resume Editing 
Select this option to close the Edit Menu and return to the file name. 
Activate Overwrite Mode/Activate Insert Mode 
This toggle option is a general option relating to the usage of the Character Bar. For information on this 
option, see Insert Mode and Overwrite Mode on page 68 in ‘The Character Bar’ section of this manual. 
Clear Text 
Will clear the file name. 
Scanning Options 
Allows you to set the scanning of the file name to Numeric or Inverse. Use this only if you are scanning a file 
name that is numeric or inverse. Press , , or  to toggle the option on or off. A checkmark (�) is 
displayed when the option is on. Press  to close the Scanning Options and save your settings - the 
current file name only. 
 

The Pen Interface Language 
The Pen Interface Language is the language in which all the menus, options and messages of the Pen 
appear.  

Changing the Interface Language 
To change the Pen interface language: 
1. Long press  until you reach the Pen Main Menu. 

2. Press  until Settings appears on the screen. 

3. Press  to enter the Settings menu. 
4. In the Settings menu, scroll using  and  until the option Set Interface Language appears on the 

screen and press . 
5. Scroll to the language you prefer by using  or . 
6. Press . 
 

The Character Bar 
The Character Bar enables you to enter text manually by overwriting or inserting characters. The Character 
Bar is available when you are in Edit mode - while editing texts that appear in the various fields of the 
applications. See the Easy Steps chapter in each application for information on when and how you can 
access the character bar. 
  

 
The Character Bar 
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Insert Mode and Overwrite Mode 
The Character Bar operates in either insert mode or overwrite mode, depending on the setting of the 
Activate Overwrite Mode/Activate Insert Mode toggle option in the Edit Menu of the current application.  
• When in insert mode (which is the default mode), the toggle option shows Activate Overwrite Mode and 

each character you select is added at the cursor.  
• When in overwrite mode, the toggle option shows Activate Insert Mode and each character you select 

replaces the highlighted character. 

Symbols, Modes and Sequences 
The Character Bar contains a basic character set (in lower case) for the selected language, as well as the 
following symbols, modes and sequences:  

 Alphabet  
The Latin alphabet sequence is the default sequence and its symbol is not displayed, unless the sequence 
has been changed. For example, if you select Numerals or Punctuation as the active sequence, the Alphabet 
symbol s displayed to allow reselecting alphabet as the active sequence (just scroll to the Alphabet symbol 
and press ). 
Also, if you had switched the scanning language of your Pen to a language that uses non-Latin characters 
(e.g., Hebrew), the Character Bar displays the Alphabet symbol, for returning to the Latin character set. 

 Punctuation 
If you scroll to the Punctuation symbol and press , punctuation becomes the active sequence and a 
series of punctuation marks is displayed. 

 Numerals  
If you scroll to the Numerals symbol and press , numerals become the active sequence and the numerals 
0-9 are displayed. 

 Multiple Characters 
The Multiple Characters symbol indicates that you are in Multiple Characters mode (which is the default). In 
this mode, you can use the Character Bar to enter more than one character at the cursor. The Character Bar 
remains open until you press  to close it. To switch to Single Character mode, scroll to the Multiple 
Characters symbol and press . The symbol is replaced with the Single Character symbol. 

 Single Character 
The Single Character symbol indicates that you are in Single Character mode. In this mode, after you enter a 
character, the Character Bar automatically closes and returns you to the text you were editing. To switch to 
Multiple Characters mode, scroll to the Single Character button and press . The symbol is replaced with 
the Multiple Characters symbol. 

 Delete 
Use the Delete symbol to delete characters. 
Note: If you are in Insert mode (see above) in a field (e.g., a file name) that has reached its maximum number 
of 200 characters and you access the Character Bar, the cursor immediately jumps to the Delete symbol. It 
won't move from the Delete symbol until you delete a character from the field. 

 Space Character 
If you scroll to the Space character symbol and press , it enters a space in the text string (inserts the 
space – when in Insert mode, or overwrites the highlighted character with a space – when in Overwrite 
mode). 
 

Accessing the Character Bar 
To access the Character Bar: 
1. To access the character bar in each text storing application, refer to the following sections of this manual: 

• In the Scan and Store application, see Editing Stored Files on page 27. 
• In the Address Book application, see Editing Addresses on page40. 
• In the Internet Links application, see Editing Links on page 45. 
• In the Tables application, see Editing Tables on page 49. 

To access the character bar when editing a file name (in any application), refer to the following: 
• When editing a file name, see The File Name Edit Menu on page 67. 

2. The Character Bar opens and the string of text you are editing is displayed above or below it. The first 
letter of the active character sequence is highlighted on the Character Bar and appears in the string of 
text, where it will be entered if you select it.  
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3. Press  or  to scroll along the Character Bar. As you move from character to character, each 
character is highlighted and appears in the string of text. 

4. Press  to select the highlighted character. The character is entered into the text string (the character 
is inserted – when in Insert mode, or the character overwrites the highlighted character – when in 
Overwrite mode).  

5. If you are in Multiple Character mode ( ), you can add additional characters. To do so, repeat steps �3 
and �4. When you are done, press  to close the Character Bar. If you are in Single Character mode 
( ), the Character Bar automatically closes. 

Entering Character Variations 
To enter a variation of a character (e.g., in upper-case or with an accent):  
1. Make sure you are in Multiple Characters mode ( ) and scroll to the letter in the Character Bar. 
2. Press  or . The Character Bar is replaced by a list of variations for the selected letter. Pressing  

initially places the cursor on the upper-case variation. Pressing  initially places the cursor on the lower-
case variation. 

 
3. Scroll to the variation you want using  or . 
4. Press . 
Note: To toggle out of the sequence for the selected letter without making a selection, press  or  again. 

Entering One Character at a Time 
To enter one character at a time: 
1. Make sure you are in Single Character mode ( ).  

If not, scroll to the Multiple Characters button ( ) and press . The Character Bar toggles to single 
character mode. It remains in this mode until you reactivate the Multiple Characters mode (scroll to the 
Single Character button ( ) and press . 

2. Scroll to the required character in the Character Bar. 
3. Press . The new character is entered at the cursor location. 

Entering Multiple Characters 
To enter multiple characters: 
1. Make sure you are in Multiple Characters mode ( ), scroll to the first character you need and press 

. 
2. Repeat for each additional character you need. 

Deleting Characters 
To delete a character: 
1. Scroll to the Delete symbol ( ) and press . 
2. If you want to delete more than one character, make sure you are in Multiple Characters mode ( ) and 

press  for each character in the sequence that you want to delete. 

Changing the Character Sequence 
To select a different active character sequence from the Character Bar:  
1. Scroll to the required button (Punctuation , Numerals , or Alphabet ). 
2. Press . The selected character sequence becomes active. 
 

The Opticard 
The Opticard, located on the back of your Pen case, is a keyboard whose keys are bar codes you can scan. 
When you are in Opticard mode and scan a bar code key from the Opticard keyboard, the corresponding 
character is inserted at the cursor location, in the Pen’s display. 

 
You can use the Opticard to edit scanned text. The Opticard is also useful when words or phrases cannot be 
scanned because letters are too large, handwritten, or are on a type of background that the Pen is unable to 
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scan. The Opticard enables you to enter these words or phrases manually by scanning in letters one at a time 
using the bar codes. 
To use the Opticard:  
1. When editing text - hold the Pen case horizontally, with the Opticard facing up and the Opticard title on 

the right. 
2. Slowly scan the Opticard key in the bottom left corner of the Opticard, from left to right or from right to 

left, to activate Opticard mode. When Opticard mode is activated, the light in the tip of the Pen blinks 
more rapidly than before. 

3. Scan the key of a letter, from right to left or from left to right, or touch the key gently with the tip of your 
Pen. The letter appears in the Pen display. 
You can use the following keys or combinations of keys to enter the letters you want: 

• Lower-Case Letters: To enter a lower-case letter, scan the key of the letter.  
• Upper-Case Letters: To enter an upper-case character, scan the Shift key and then scan the 

letter key. 
• CAPS LOCK: To activate/deactivate CAPS LOCK, scan Shift twice. Activating CAPS LOCK 

enables you to enter letters in upper case only. 
• Ctrl Key: To enter a controlled character, scan the Ctrl key and then the letter key. Controlled 

characters can be entered only for the active character set. The Ctrl key can be used to enter 
characters specific to other languages, such as French or German. To enter a character specific 
to another language, such as an accent, scan the Ctrl key, scan the accent and then scan the 
letter corresponding to the accent. 

• Ctrl + Shift: To enter a controlled character in upper case, scan the Ctrl key, then scan the Shift 
key (or Shift, then Ctrl) and then scan the letter key. 

• Space: To enter a space, scan the spc key. 
• Delete: To delete the previous character, scan the Shift key and then scan the del key. 

4. Continue scanning in characters as required. 
5. When you are finished, scan the Opticard key again to return to normal scanning. 
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Additional Information 
 

Pen Care and Cleaning 
Your Pen conforms to the highest standards of craftsmanship and manufacture. To ensure its continued 
excellent performance, please adhere to the following instructions for care and cleaning: 
• Protect the Pen from direct sunlight, heat, dampness and dust. Do not drop or knock the device; keep it 

in its protective plastic case to avoid scratches. ALWAYS replace the tip’s protective cover when not in 
use. 

• Clean the Pen only with a soft, dry cloth. Never use a wet cloth or solvents such as benzene or diluting 
agents. 

• NEVER clean, wipe or tamper with the Pen’s tip. It contains a sensitive electronic eye that could become 
damaged. 

• Should your Pen require servicing, contact the retail outlet where you purchased your unit. 
 

Pen Batteries 
The Pen uses two AAA batteries. To check the batteries, select View Battery Status from the Information 
menu in the Pen Main Menu. 
If the batteries are low, the following picture of a battery with a slash through it appears on the Pen’s display: 

 
 
When the batteries are about to run out, the Pen shuts down automatically. 
When replacing batteries, use only high-quality, alkaline batteries. 
 

Pen Technical Data 
 
Processor  ARM 7 TDMI 
RAM memory 192KB 
ROM memory 8MB minimum 
Socket for flash memory cards 2MB/4MB/8MB 
Communications Serial (USB Cable, IR) 

IrOBEX 
Optical head 128 pixels linear array image sensor 
 400 DPI resolution  
Display dimensions 61mm x 20mm/2.4” x .8”  
 122 x 32 pixel resolution 
Supply voltage Two 1.5v AAA batteries 
Weight  90 grams/3 oz. (not including batteries and/or flash memory 

card) 
Size Length (with cover): 163 mm/6.4” 
 Width: 38 mm/1.5” 
 Height: 23 mm/1” 
• Low power consumption 
• Compliant to FCC class B 
• Compliant to CE standards 
• UL listed 
 

Extending the Pen’s Memory 
It may be possible to extend the Pen’s memory. This will allow enhancing the Pen with additional Pen 
Components. Extending the Pen’s memory is done with WizCom Technologies’ Memory Extension Kit 
(MEK) product. 
Important: 
Please contact our offices for more information on extending your product (see Contact and Support 
Information on page 6). 
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Advanced Desktop Features 
The Desktop main functionality is to enable the Pen-PC Communications, specifically supporting the Send 
Stored Files to PC and Scan to PC functions. These functions are described in detail throughout this 
manual. 
 
In addition to the main Desktop functions, there are additional options that are available in the Desktop. 
Please refer to the QuickLink-Pen Elite Desktop Help file for full information of the Desktop options. 
 
Following is a short description of some of these options and what they can be used for. 

The Desktop Icon in the System Tray 
When the QuickLink-Pen Elite Desktop is running, an icon ( ) appears in the system tray on the right side 
of the Windows taskbar at the bottom of the screen. If, during the QuickLink-Pen Elite Desktop installation, 
you had specified that the Desktop should launch on startup, the icon appears automatically each time you 
start your computer. Otherwise, it appears only when you start the Desktop application manually. 
 
This icon makes it easy to execute the most common Desktop commands. When you click on the icon, a 
pop-up menu appears. The menu is particularly useful if you are scanning directly into an application, 
because it allows you to execute commands without having the QuickLink-Pen Elite Desktop window open. 
The pop-up menu has the following options: 

• Show/Hide Window - Displays or hides the QuickLink-Pen Elite Desktop window. 
• Turn Pen Communications On/Off - Enables or disables communications between the Desktop and the 

Pen.  
• When Pen communications are on, the communications port is busy (you can see which one, in the 

Communications Settings dialog of the Desktop, see Communications Settings on page 73). You 
cannot use this port simultaneously for any other purpose unless you exit the Desktop application. 

• When Pen Communications are off, the Desktop cannot detect communications from the Pen and the 
port is free for other purposes. 

• Pen-PC File Transfer Settings - Displays the Pen-PC File Transfer Settings dialog box, so that you can 
view and modify the file transfer settings of the Send Stored Files to PC function. 

• Scan to PC Settings - Displays the Scan to PC Settings dialog box, so that you can select the character 
to be inserted after each line of text you scan. 

• Log - Displays the log of the Send Stored Files to PC operations. 
• About - Displays the version number of the Desktop application. 
• Exit - Closes the Desktop application. 

Add\Remove Pen Components Dialog 
This dialog, available from the Pen Communications menu of the Desktop, can be launched only when the 
Pen is connected and In Upgrade Mode. It shows Pen Components, which are the actual software files for 
the Pen. 
• The left window displays the Pen Components stored on the PC (only *.qlb files that reside in the “Pen 

Components” folder under the Desktop installation directory). 
• The right window displays the Pen Components that are on the connected Pen. 
This dialog is for advanced users only. You will probably never need to use it, unless for Support purposes – 
while guided by our Support Team. Its main purpose was to allow for the upgrading of the Pen – but this 
functionality is currently covered (in a more user-friendly manner), in the various options of the QuickLink-
Pen® Elite CD-ROM. Nonetheless, here are a few of this dialogs functions, that may come in handy: 
• Menu Order – press this button to view and change the current order of the options in the Pen Main 

Menu. 
• Details – press this button to open a text file displaying the details of all Pen Components currently 

installed on the connected Pen. This is useful for support issues. 
• Current flash memory status – this bar displays the status of the flash card in your Pen (this is the 

external card, onto which information and files can be added or deleted from). 
• Compact – press this button to compact the space the Pen components use on the Pen’s flash memory 

card, thus maximizing the amount of free space. This option is identical to the Pen option Compact 
Memory (see page 65). It is advised to use the Pen option, since it does not require Pen-PC 
Communications. 
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Optimize Pen File System 
This function, available from the Pen Communications menu of the Desktop, can be performed only when 
the Pen is connected and In Upgrade Mode. The function compacts the space that the data and image files 
use on the Pen’s flash memory card and frees up areas that contain deleted application data. 
It is worthwhile to optimize your Pen’s file system from time to time. In addition, it is a good idea to do this 
when you have deleted a lot of data from your Pen. 
Important: Do NOT abort the Optimize Pen File System process before it is completed. Failure to complete 
the process may result in the loss of all data from your Pen. 

Log 
To view a log containing the history of the last three Scan and Store sessions, select Log from the View 
menu. 

Communications Settings 
This dialog, available from the Pen Communications menu of the Desktop, displays the settings used for 
Pen-PC communications. Any time you insert the USB Cable into the PC, the correct settings are 
automatically written to this dialog. This dialog serves as information or when troubleshooting 
communications problems. If you cannot set up the Pen-PC Communications, you may need to change 
settings in this dialog, either according to directions from our support team, or according to directions given in 
the Communications Wizard (see following item). 

Communications Wizard 
This dialog, available from the Help menu of the Desktop, runs a wizard which instructs you step-by-step, on 
how to establish Pen-PC communications, then confirms these communications and writes their settings into 
the Communications Settings of the Desktop. 
Important: Communications settings should be established automatically if you have performed the one-time 
Set Up Product on PC procedure from the CD and if the USB Cable is inserted into the PC. 
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Troubleshooting 
Here are some common problems you may run into and how to try and fix them yourself. 
In all cases: if you cannot fix the problem, please contact our Support Team (see Contact and Support 
Information on page 6). 
 
Problem: 

I need to restore my Pen. Things are missing! 
Solution: 

At times, an upgrade procedure performed on your Pen may fail, or the flash card of your Pen may 
be damaged. The result may be that certain options have disappeared from your Pen. 
To fix the Pen: 
1. Replace the Pen batteries with fresh ones. 
2. Confirm that the flash card is properly inserted in its place. 
3. Turn the Pen on as follows: press  and keep pressing it while you press the power button 

. 
4. Run one of the Add-On procedures from the CD-ROM. Follow the instructions. If, when 

requested to select the Enter Upgrade Mode option, it is missing, select the option named PC-
Controlled Communications, or Communications instead (they are the same). 

All the add-on procedures have an initial stage in which the original Pen is restored. This should fix 
the problem. 
If you cannot fix the problem, please contact our Support Team (see Contact and Support 
Information on page 6) 
 

Problem: 
I added an add-on application (Address Book, Internet Links, Tables) but the interface language of 
the new application is always in English – even if the Pen is set to a different interface language. 

Solution: 
Apparently you have added an interface language to your Pen – after adding the add-on application. 
Please rerun the installation of the add-on application from the CD-ROM. It will complete the interface 
language for the add-on application – according to any interface languages existing on your Pen. 
 

Problem: 
I need to reinstall the Desktop application. 

Solution: 
Please click on the Set Up Product on PC button from the main menu of the CD-ROM, skip the 2 
screens related to the USB Cable and driver (press >>) and then run the desktop installation from the 
button Click here to run Desktop Installation. 
 

Problem: 
I cannot get the Pen and PC to communicate, or I get an error message on the PC. 

Solution: 
Please make sure the Desktop is not running (if it is, select Exit from the File menu) and connect the 
cable. Now launch the Desktop. The com port number assigned by Windows for the cable should be 
automatically detected by the Desktop. 
 

Problem: 
The error message ‘Word not found’ appears when trying to define a word in a stored file. 

Solutions: 
• Confirm that the Scanning Language of the file is set to the language of the text you are trying to 

define. 
• It may be that the word you have scanned is not included in the dictionary, for example, proper 

names are not included. 
 
Problem: 

How can I fix a calibration error?  
Solution: 

Replace the batteries with fresh ones. If this does not solve the problem, please contact our support 
team (see Contact and Support Information on page 6) 
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Problem: 

My Pen will not turn on, or it turns on improperly.  
Solutions: 

• Check to see whether the Pen is turned on, that it is in scanning mode and that the protective 
cover has been removed from the Pen tip. 

• Check whether you are scanning regular text in inverse text mode or inverse text in regular text  
• Replace the batteries with fresh ones. 
• Turn the Pen on as follows: press  and keep pressing it while you press the power button . 
 

Problem: 
The Pen wheels are squeaky. How do I solve this?  

Solution: 
The wheels should not squeak and they really do not tend to. But if you find that your wheels squeak 
even for a moment, you can run the tip back and forth on paper with just a bit of pressure to eliminate 
the noise, or use the edge of a pencil-tip to cause a tiny amount of graphite to fall between the 
wheels and the tip which will lubricate the axle. The problem should be temporary but if not, the Pen 
can be exchanged. 
 

Problem: 
When I insert the earphone plug into its outlet, the Pen shuts off. What should I do?  

Solution: 
This problem occurs when the plug is not inserted properly. If it is not inserted firmly, the connections 
are loose, which causes the Pen to switch itself off automatically. Push the earphone plug very firmly 
into its outlet, until you hear a “click” sound. 

 
Problem: 

Why can’t I hear the Pen read out loud? 
Solutions: 

• Reading out loud is supported only for English texts. Non-English texts will not be read out loud 
and a message will appear if attempting to do so. Therefore, please confirm that the Scanning 
Language is set to English. 

• Check whether the volume is high enough – both on earphones and in the Set Volume option. 
• If you are using an earphone, check whether its plug is connected firmly to the outlet (you should 

hear a “click” sound which verifies that the earphone is indeed connected). 
 
Problem: 

When trying to read a paragraph aloud, I get an error message No support for reading aloud 
in…(name of language). Why? 

Solution: 
You are attempting to read aloud texts that were entered into the file when its scanning language was 
not set to English. Only texts, scanned when the scanning language is set to English, can be read 
aloud. For more information, please refer to Select Language on page 26 and Reading Paragraphs 
Aloud on page 28. 

 
Problem: 

The text in the display appears upside down. 
Solution: 

Adjust the Right/Left Handed mode. 
 

Problem: 
The error message Excessive lighting appears on the display. 

Solution: 
Move the Pen away from the strong light source (such as sun, lamp, etc.) shining directly on the tip.  

 
Problem: 

The error message Scanned too fast appears on the display. 
Solution: 

Scan again - more slowly. 


